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WARNING

Thank you for purchasing automation equipment from Automationdirect.com™. We want your new DirectLOGIC™
automation equipment to operate safely. Anyone who installs or uses this equipment should read this publication (and
any other relevant publications) before installing or operating the equipment.

To minimize the risk of potential safety problems, you should follow all applicable local and national codes that regulate
the installation and operation of your equipment. These codes vary from area to area and usually change with time. It is
your responsibility to determine which codes should be followed, and to verify that the equipment, installation, and
operation are in compliance with the latest revision of these codes.

At a minimum, you should follow all applicable sections of the National Fire Code, National Electrical Code, and the
codes of the National Electrical Manufacturer’s Association (NEMA). There may be local regulatory or government
offices that can also help determine which codes and standards are necessary for safe installation and operation.

Equipment damage or serious injury to personnel can result from the failure to follow all applicable codes and
standards. We do not guarantee the products described in this publication are suitable for your particular application,
nor do we assume any responsibility for your product design, installation, or operation.

Our products are not fault—tolerant and are not designed, manufactured or intended for use or resale as on—line control
equipment in hazardous environments requiring fail-safe performance, such as in the operation of nuclear facilities,
aircraft navigation or communication systems, air traffic control, direct life support machines, or weapons systems, in
which the failure of the product could lead directly to death, personal injury, or severe physical or environmental
damage ("High Risk Activities”). Automationdirect.com™ specifically disclaims any expressed or implied warranty of
fitness for High Risk Activities.

For additional warranty and safety information, see the Terms and Conditions section of our Desk Reference. If you
have any questions concerning the installation or operation of this equipment, or if you need additional information,
please call us at 770-844—4200.

This publication is based on information that was available at the time it was printed. At Automationdirect.com™ we
constantly strive to improve our products and services, so we reserve the right to make changes to the products and/or
publications at any time without notice and without any obligation. This publication may also discuss features that may
not be available in certain revisions of the product.

Trademarks

This publication may contain references to products produced and/or offered by other companies. The product and
company names may be trademarked and are the sole property of their respective owners. Automationdirect.com™
disclaims any proprietary interest in the marks and names of others.

Copyright 2001, Automationdirect.com™ Incorporated
All Rights Reserved

No part of this manual shall be copied, reproduced, or transmitted in any way without the prior, written consent of
Automationdirect.com™ Incorporated. Automationdirect.com™ retains the exclusive rights to all information
included in this document.



AVERTISSEMENT

Nous vous remercions d’avoir acheté I'équipement d’automatisation de Automationdirect.com™. Nous tenons a ce que
votre nouvel équipement d’automatisation DirectL OGIC™ fonctionne en toute sécurité. Toute personne qui installe ou
utilise cet équipement doit lire la présente publication (et toutes les autres publications pertinentes) avant de l'installer ou de
lutiliser.

Afin de réduire au minimum le risque d’éventuels problémes de sécurité, vous devez respecter tous les codes locaux et
nationaux applicables régissant l'installation et le fonctionnement de votre équipement. Ces codes difféerent d’'une région a
lautre et, habituellement, évoluent au fil du temps. Il vous incombe de déterminer les codes a respecter et de vous assurer
que I'équipement, linstallation et le fonctionnement sont conformes aux exigences de la version la plus récente de ces
codes.

Vous devez, a tout le moins, respecter toutes les sections applicables du Code national de prévention des incendies, du
Code national de I'électricité et des codes de la National Electrical Manufacturer’s Association (NEMA). Des organismes de
réglementation ou des services gouvernementaux locaux peuvent également vous aider a déterminer les codes ainsi que
les normes a respecter pour assurer une installation et un fonctionnement sirs.

L'omission de respecter la totalité des codes et des normes applicables peut entrainer des dommages a I'équipement ou
causer de graves blessures au personnel. Nous ne garantissons pas que les produits décrits dans cette publication
conviennent a votre application particuliére et nous n'assumons aucune responsabilité a I'égard de la conception, de
linstallation ou du fonctionnement de votre produit.

Nos produits ne sont pas insensibles aux défaillances et ne sont ni congus ni fabriqués pour l'utilisation ou la revente en tant
qu’équipement de commande en ligne dans des environnements dangereux nécessitant une sécurité absolue, par
exemple, I'exploitation d’installations nucléaires, les systemes de navigation aérienne ou de communication, le contréle de
la circulation aérienne, les équipements de survie ou les systémes d’armes, pour lesquels la défaillance du produit peut
provoquer la mort, des blessures corporelles ou de graves dommages matériels ou environnementaux ("activités a risque
élevé”). La société Automationdirect.com™ nie toute garantie expresse ou implicite d’aptitude a 'emploi en ce qui a trait
aux activités a risque élevé.

Pour des renseignements additionnels touchant la garantie et la sécurité, veuillez consulter la section Modalités et
conditions de notre documentation. Si vous avez des questions au sujet de l'installation ou du fonctionnement de cet
équipement, ou encore si vous avez besoin de renseignements supplémentaires, n’hésitez pas a nous téléphoner au
770-844-4200.

Cette publication s’appuie sur linformation qui était disponible au moment de Iimpression. A la société
Automationdirect.com™, nous nous efforgcons constamment d’améliorer nos produits et services. C’est pourquoi nous
nous réservons le droit d’apporter des modifications aux produits ou aux publications en tout temps, sans préavis ni quelque
obligation que ce soit. La présente publication peut aussi porter sur des caractéristiques susceptibles de ne pas étre offertes
dans certaines versions révisées du produit.

Marques de commerce

La présente publication peut contenir des références a des produits fabriqués ou offerts par d’autres entreprises. Les
désignations des produits et des entreprises peuvent étre des marques de commerce et appartiennent exclusivement a
leurs propriétaires respectifs. Automationdirect.com™ nie tout intérét dans les autres marques et désignations.

Copyright 2001, Automationdirect.com™ Incorporated
Tous droits réservés
Nulle partie de ce manuel ne doit étre copiée, reproduite ou transmise de quelque fagon que ce soit sans le consentement
préalable écrit de la société Automationdirect.com™ Incorporated. Automationdirect.com™ conserve les droits
exclusifs a I'égard de tous les renseignements contenus dans le présent document.
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Manual Overview

Overview of this
Manual

Other Reference
Materials

Who Should Read
This Manual

Technical Support

This manual describes the installation and
operation of the Ethernet Base Controller.
You will find the necessary information for
configuring the H2-EBC(-F) and
H4-EBC(-F), installing the module in a
DL205 or DL405 I/0 base and connecting
the EBC to a 10BaseT or 10BaseFL
Ethernet network.

You may find other technical manuals useful for your application. For technical
information related to your PC—based control software or your PC, please refer to
the appropriate manual for that product. For more information about the
DirectLOGIC™ products, you may want to read the following:

e DL205 User Manual
e DL405 User Manual

You will find this manual helpful for setup and installation if you have chosen to use all
of the following:

e PC-based Control (rather than a traditional PLC CPU)
e Qur DL205 or DL405 I/0O
¢ One of our Ethernet Base Controllers for communication to the 1/0 rack

A familiarity with Ethernet communications and with the setup and installation of
PLCs is helpful. An understanding of electrical codes and industrial control is
essential.

We strive to make our manuals the best in the industry. We rely on your feedback to
let us know if we are reaching our goal. If you cannot find the solution to your
particular application, or, if for any reason you need additional technical assistance,
please call us at

770-844-4200

Our technical support team is happy to work with you in answering your questions.
They are available weekdays from 9:00 a.m. to 6:00 p.m. Eastern Time. We also
encourage you to visit our website where you can find technical and nontechnical
information about our products and our company.

www.automationdirect.com

If you have a comment or question about any of our products, services, or manuals,
please fill out and return the ‘Suggestions’ card that was shipped with this manual.
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Conventions Used
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The “light bulb” icon in the left-hand margin indicates a tip or shortcut.

T

The “note pad” icon in the left-hand margin indicates a special note.

—
THE

AN U; The “exclamation mark” icon in the left-hand margin indicates a warning or caution.

P These are very important because the information may help you prevent serious
O personal injury or equipment damage.

Key Topics for The beginning of each chapter will list the introauction I

Each Chapter key topics that can be found in that chapter. —
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Ethernet Base Controller Overview

I/0 Values Stored
in Cache Memory

The Ethernet Base Controller (EBC) provides a low-cost, high-performance
Ethernet link between a PC-based Control system, DL205 and DL405 I/O bases.
The EBC occupies the CPU position of the PLC base and communicates across the
backplane to input and output modules.

Although, the Ethernet Base Controller occupies the CPU slot in the PLC base, the
control function is not performed by the EBC. The control function is performed by
PC—-based Control software (which is purchased separately) running on a PC. The
function of the EBC is to:

e process analog and digital input signals

o format the I/O signals to conform to the Ethernet standard

e transmit the signals to the PC-based controller

e receive and translate output signals from the PC-based Control software

e distribute the output signals to the appropriate output module in the
base

The EBC module continually scans all /O and stores the most recent values in
cache memory. The cache memory contents are available to the PC-based Control
software as a block of data or by individual slot location. The EBC reads all channels
of digital modules on each scan. It reads one channel of each analog module on
each scan, updating that value in cache memory. On the next scan, the EBC
sequences to the next channel and updates that value in cache memory, and so on.

Typically, PC-based Control will request all input and output values at the same time
from the EBC. The EBC passes the cache memory values for all channels of all input
and output modules. By using this method, very fast response times can be
achieved by the PC-based Control system.

Control Room Machine Control
O© mo
PC-based o mm = goeg
Control
Ethernet BE B8 {BE {88 88 {8
S;erial
H2-EBC

Process Control
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Industry Standard

Ethernet

Q

\N//
/NN

H2-EBC and
H2-EBC-F

H4-EBC and
H4-EBC-F

RS232C
Serial Port

The H2—-EBC and H4-EBC modules support industry standard 10BaseT Ethernet
communications, and the H2—EBC—F and H4—EBC-F modules support 10BaseFL (fiber
optic) Ethernet standards. All EBCs offer 10Mbps transfer rates between your PC
application and your 1/O base.

WARNING: For deterministic Ethernet communication you must use a dedicated
network of EBC modules connected to your PC-based control system. The EBC
modules and the PC running PC-based Control Software must be the only devices
on the network.

The H2-EBC(—F) installs in the CPU slot of a DL205 base and communicates across
the backplane to digital and analog input and output modules. The H2—-EBC(—F)
does not support remote I/O or Specialty Modules.

H2-EBC H2-EBC-F
| ol =]=] | ~B8
| P = = | | =23
Enmag g sssss EF ﬁ

H2-EBC RJ1 2 H2-EBC-

Serial
ﬁ/ —/ Port i

®
K ®
. M1

The H4-EBC(—F) installs in the CPU slot of a DL405 base and communicates across
the backplane to digital and analog, input and output modules. The H4—-EBC(—F)
supports up to three expansion I/O bases (see page 2—-19), and it supports the
D4-HSC High Speed Counter Module. The H4-EBC(—F) also serves as the power
supply for the local base. Expansion bases have their own power supplies.

RJ45 Port
for 10Base-T

ST bayonet
for 10Base-FL

| 1

Oiect JSEBC "% " Direct JSEBC "o TR
v . ey .
RJ12 RJ12
N © Serial L{ Serial
1 @ Port Port
@) ‘
| |
i e
" @
1|
RJ45 Port ST bayonet
@ for 10Base-T for 10Base-FL
. .
(1 —°

An RS232C serial port on-board the EBC module allows serial communication to an
operator interface device or other serial device. See your PC-based Control
software documentation to determine whether this EBC feature is supported.

=]
—
=
]
[o}
c
(9]
=
o
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Frequently Asked Questions

Q. What is Ethernet?
A. Ethernet is a specification which defines cable type and signalling methods to be
used in a local-area-network (LAN). An Ethernet network transmits packets of
information between computers at speeds of 10 to 100 million bits per second
(Mbps). Currently the most widely used version of Ethernet technology is the 10Mbps
twisted-pair variety. Ethernet allows multi-vendor products to communicate using
common software protocols.
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Q. Which protocols are supported by the EBC?
A. The H2-EBC(-F) and the H4—EBC(-F) support IPX (originated by Novell) and
UDP/IP (Universal Datagram Protocol/Internet Protocol). The Windows NT™
operating system supports both protocols. The UDP/IP protocol is supported within
the TCP/IP suite.

Q. What Ethernet standards should | be familiar with?
A. Below is a short list of most commonly used Ethernet cabling standards and their
key characteristics.

e 10Base-2 — Thin coaxial cable, which supports a maximum of 30
stations per network and is limited to 185 meters (607ft.) per cable
segment.

o 10Base-5 — Thick coaxial cable, which supports a maximum of 100
stations and is limited to 500 meters (1,640ft.) per segment.

e 10Base-F — Plastic or Glass Fiber Optic maximum of 1024 stations and
distances depend on signaling technology and medium used but can
commonly support up to 2 Kilometers.

o 10Base-T — Unshielded Twisted Pair, which supports a maximum of
1024 stations with a segments of 100 meters, but distance is truly based
on signal loss in decibels (less than 11.5dB loss source to destination).

Q. Which Ethernet specifications are required to install an EBC system?

A. None. Detailed Ethernet specifications are not necessary for implementing the
EBC system.

Q. How do | connect to an Ethernet network?

A. Different types of Ethernet media may be connected to a single LAN network
solution using repeaters, bridges, and adaptor type products. A number of vendors
offer adaptors or transceivers, which provide interconnection of different types of
Ethernet cabling.




Installing the
H2-EBC(-F) or
H4-EBC(—F)

In This Chapter. . ..

— Setting the Module ID

— The H2—EBC DIP Switch

— The H4—-EBC DIP Switch

— Inserting the H2—EBC or H2—-EBC—F into the Base
— Inserting the H4—EBC or H4—-EBC-F into the Base
— DL205 Power Wiring and Grounding

— H4-EBC Power Wiring and Grounding

— 10BaseT Network Cabling

— 10BaseFL Network Cabling

— Maximum Ethernet Cable Length

— Calculating the Power Budget for the H2-EBC(—F)
— Power Consumption Chart (DL205 Modules)

— Calculating the Power Budget for the H4-EBC(—F)
— Power Consumption Chart (DL405 Modules)

— DL405 Local and Expansion 1/O
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Setting the Module ID

Three Methods for
Setting Module ID

Setting Module ID
with DIP Switches

Setting Module ID
with Software Tool

Each Ethernet Base Controller must have a Module ID in order to be recognized on
the network, and each Module ID must be unique. Duplicate Module IDs on the same
network will cause unpredictable results and must be avoided.

There are three methods for setting the Module ID, and they are the same for the
H2-EBC and the H4-EBC modules. You can set the Module ID using:

e The DIP switch on the EBC module

o The NetEdit software utility

e The software utility in your PC-based Control software (if a utility is
provided)

We recommend using the DIP switch to set the Module ID because the DIP switch is
simple to set, and the Module ID can be determined by looking at the physical
module, without reference to a software utility.

You can use the DIP switch to set the Module ID to a number from 1 —63. Do not use
Module ID 0 for communications. The only pupose of Module ID 0 is to allow
communications with a PC while changing the Module ID.

If the DIP switch is setto a number greater than O, the software tools are disabled
from setting the Module ID. Again, the software tools will only allow changes to the
Module ID if the DIP switch setting is 0 (all switches OFF).

The DIP switch settings are read only at powerup. You must cycle power if you
change the DIP switches.

Software changes to the Module ID do not require cycling power. To set the Module
ID using one of the available software tools, do the following:

o Check to be sure all DIP switches are set to the off position,
Module ID = 0 (see page 2—-3 or 2—4)

¢ Insert the module in the base (see page 2-5)

e Connect the power wiring (see page 2-6)

e Connect module to the Ethernet network (see page 2—-8 through 2—-10)
e Apply power

e Link to the module and change the Module ID using the software of your
choice. Remember to update the module before exiting the software.
See note below.

NOTE: Set the Module ID using the method recommended for your PC-based
Control software. The use of NetEdit to set the Module ID is described in Chapter 3.
Some PC-based Control software packages may make automatic updates to the
EBC module configuration, overwriting the configuration developed in NetEdit.
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The H2-EBC DIP Switch

The H2-EBC (-F) The EBC DIP switch contains eight individual switches, but only six of these are
DIP Switch active. You will find that the printed circuit board is labeled 0 — 7. The numbers on the
printed circuit board indicate the power of 2 represented by each individual switch.
For example, switch 0 represents 29 (or 1), switch 1 is 21 (or 2), switch 2 is 22 (or 4),
and so on. The figure below shows the binary value of each switch in parentheses ().

H2-EBC (-F) [T )

The numbers (0-7) printed on the
circuit board indicate the power of 2
represented by each slide switch.

alalalal 11 il

7 6 5 4
25 24 23 22 21 20
(32)(16) (8) (4) (2) (1) —— Binary Value
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Not Used

The Module ID equals the sum of the binary values of the slide switches set in the ON
position. For example, if you set slide switches 1, 2, and 3 to the ON position, the
Module ID will be 14. This is found by adding 8+4+2=14. The maximum value you can
set on the DIP switch is 32+16+8+4+2+1=63. This is achieved by setting switches 0
through 5 to the ON position.
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The H4-EBC DIP Switch

The H4-EBC (-F) The H4-EBC DIP switch contains eight individual switches, but only six of these are

DIP Switch active. Two are not used. Notice that the individual switches are labeled 0 — 7 on the
printed circuit board. The numbers on the printed circuit board indicate the power of
2 represented by each individual switch. For example, switch 0 represents 20 (or 1),
switch 1is 2! (or 2), switch 2 is 22 (or 4), and so on. The figure below shows the binary
value of each switch in parentheses ().

ON OFF N
o
< —
Not Used {m H4-EBC (-F)
S5 <
T O
ok i
25 o L1
N | i
~| L[
= :
— |
. e The numbers (0-7) printed on the I
25 24 23 22 21 20 circuit board indicate the power of
(3'2)(1'6) (é) ( 4) (é) (i) 2 represented by each switch.

/

Binary Value

The Module ID equals the sum of the binary values of the individual switches set in the
ON position. For example, if you set switches 1 and 3 to the ON position, the Module
ID will be 10. This is found by adding 8+2=10. The maximum value you can set on the
DIP switch is 32+16+8+4+2+1=63. This is achieved by setting switches 0 through 5 to
the ON position. The DIP switch must be set to a number greater than zero.
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Inserting the H2-EBC or H2-EBC-F into the Base

The H2—-EBC plugs into the CPU slot of any DL205 base.
e Locate the grooves on the inside top and bottom of the DL205 base.

e Align the module with the grooves and slide the module into the slot until
the face of the module is flush with the power supply.

e Push in the retaining clips to secure the module.
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Align the H2-EBC module with the Push the retaining clips

grooves in the base and slide it in. in to secure the module in
the DL205 base.

Intalling the H4-EBC or H4-EBC-F onto the Base

The H4—-EBC installed in the CPU position of any DL405 1/O base.

e The EBC has two plastic tabs at the
bottom and a screw at the top.

¢ With the device tilted as shown, hook
the plastic tabs into the notches at the
bottom of the base.

e Gently push the top of the module
toward the base until the back of the
module is flush with the base.

e Tighten the screw at the top of the
device to secure it to the base.

== = E\\

Spring loaded
securing screw

\=

d
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DL205 Power Wiring and Grounding

The power wires for the DL205 are not connected directly to the H2—-EBC as they are
on the H4-EBC. The DL205 power supply is an integral part of the base and
separate from the EBC. The DL205 also has three power options: 12/24VDC,
125VDC, and 120/240VAC.

&m | = | == | = |
5 = s
czcgc% M M M M )
Be
£
The diagram shows the terminal 110/220 VAC Base Terminal Strlp
connections located on the power supply @
of the DL205 bases. The base terminals G
can accept up to 16 AWG. You may be @
able to use larger wiring depending on
the type of wire used, but 16 AWG is the @® @6
recommended size. @
NOTE: You can connect either a || | +—
— 120 VAC or 240 VAC supply to the AC &) 24 VDC OUT
= terminals. Special wiring or jJumpers are — 02A
— not required as with some of the other
DirectLOGIC™ products.
12/24 VDC Base Terminal Strip 125 VDC Base Terminal Strip
) = ) t—/
12 -24 VDC 90 — 264 VDC
@ [ @/’__l
o© D2-09BDC-2 i o©
@ G range is / @ G
&) 115-264 VDC &)
) || | +—
24 VDC OUT
&) @)|| | —— o02a

WARNING: Once the power wiring is connected, install the plastic protective cover.
When the cover is removed there is a risk of electrical shock if you accidentally touch
the wiring or wiring terminals.

\Vd
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/NN
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H4-EBC Power Wiring and Grounding

The power connection terminals are under the front cover of the Ethernet Base
Controller. The list below describes the function of each of the terminal screws.

e Relay — normally-open contact indicates that the EBC’s link to hub or
PC is good. Link Good indicator light is also on.

e 24VDC Auxiliary Power — can be used to power field devices or I/O
modules requiring external power. It supplies up to 400 mA of current at
20-28VDC, ripple less than 1 V P-P.

e Logic Ground — internal ground to the system which can be tied to field
devices or communication ports to unite ground signals.

e Chassis Ground — where earth ground is connected to the unit.

e AC Power —where the line (hot) and the neutral (common) connections
are made to the EBC.

o 110/220 Voltage Select — a jumper across two of the terminals
determines the voltage selection. Install the jumper to select 110VAC
input power, or remove the jumper to select 220VAC power input.

o =
S @
Qo
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AN D/ WARNING: Damage will occur to the power supply if 220 VAC is connected to the
S U terminal connections with the 115 VAC jumper installed. Once the power wiring is
O connected, install the protective cover to avoid risk of accidental shock.

EBC Wiring The following diagram shows the appropriate connections for each terminal. Note
that you should install a jumper between logic ground and chassis ground for best
noise immunity.

110/220 VAC
Terminal Strlp Bi’wt H‘I-EBV(EZR 11o/fig\ég\;:D
LOGIC 4%EBC ERROR ACTIVITY
Install jumper between logic Sovpe. 1a Koyo RELAY BATT Low
and chassis ground for best SO0 @
noise immunity if using RELAY| > Relay Soure 1A @ @
D4-0X-1 type base. & an ] o @
2|
2AVDcourT+ @ 24V Auxiliary r @ Q ]
0.4A L @ Power SﬁvADCOUL @ |E|
e 7 @ — Logic Ground R [E)
@ @ __ Chassis c01®
Ground )
v, D — ACLine B
50VA
Install jumper for 110 VAC, e @ — AC Neutral e & ]
leave off for 220 VAC. o T 1
See Warning above. O/P:Vg @ > 110/220 , D) (C—)
e @ Voltage Select : : .

?
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and Setup

10BaseT Network Cabling

EBC Supports Two Two types of EBC modules are available. One type supports the Ethernet 10BaseT

Standards

10BaseT
Connections

10BaseT

12345678

8-pin RJ45 Connector
(8P8C)

standard, and the other supports the 10BaseFL standard. The 10BaseT standard
uses twisted pairs of copper wire conductors, and the 10BaseFL standard is for fiber
optic cabling.

Direct 4% EB ) Clineenn
f — —loaic PWEDV L. o
|~BE ' K,,,? RRRRR ) | R
== eria
88 20e W] O
vl . © RS232
Serial @ - IE
Port @ Q 1]
ﬁ RS232 3'4:10“:7 E
ﬁ )| [ RJ45
) for
RJ45 ® 10BaseT
[ for ® _—
10BaseT s

The EBC has an eight-pin modular jack that accepts RJ45 connector plugs. UTP
(Unshielded Twisted-Pair) cable is rated according to its data-carrying ability
(bandwidth) and is given a category number. We strongly recommend using a
Category 5 (CAT5) cable for all Ethernet 10BaseT connections. For convenient and
reliable networking, we recommend that you purchase commercially manufactured
cables (cables with connectors already attached).

To connect an EBC (or PC) to a hub or repeater, use a patch cable (sometimes
called a straight-through cable). The cable used to connect a PC directlyto an EBC
or to connect two hubs is referred to as a crossover cable.

Patch (Straight—through) Cable Crossover Cable

EBC HUB EBC PC
OR/WHT OR/WHT R/WHT GRN/WHT
o+ 1T0R om| ! BP+ | |TD+ 1 [og GRN| 1 TD+
D~ 2 'eRNWHT — GRNwHT| 2 707 | |TP- 2 [GRNWHT ORMWHT| 2 TD-
RD+ 3 3 TD+ RD+ 3 3 RD+
S [BLU BLU| 3 S [BLU BLU| §
5 BLU/WHT BLU/WHT 5 5 | BLUWHT BLU/WHT 5
~ >[G@RN GRN . GRN OR
RD 3 BRN/WHT BRN/WHT ETD D~ ¢ BRNMWHT BRNWHT| & AP~
& [BBN BBN| 4 g | BRN BRN| 4
RJ45 RJ45 RJ45 RJ45

This diagram illustrates the standard wire positions in the RJ45 connector.
We recommend all EBC 10BaseT cables to be Category 5, UTP cable.

NOTE: See page 2—-10 for 10BaseT distance limitations.
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10BaseFL Network Cabling

EBC Supports Two Two types of EBC modules are available. One type supports the Ethernet 10BaseT

Standards standard, and the other supports the 10BaseFL standard. The 10BaseT standard
uses twisted pairs of copper wire conductors, and the 10BaseFL standard is for fiber
optic cabling.

— Direct e S
I LOGIC 405EBC N —
” ME E Koyo ., siTT Low 2\”_2'
o eria
B8 RJ12 e e © Port
Serial L@l - @ RS232 =3
Port 7 ] %
RS232 sapeo (-2 =
@ . o) =
o H @ o
| ©) S5
® . ® ST-style
@ || D Bayonet
ST-style N for
Bayonet ] 10BaseFL
for el @
10BaseFL i o
10BaseFL Each module has two ST-style bayonet connectors. The ST-style connector uses a
Connections quick release coupling which requires a quarter turn to engage or disengage. The

connectors provide mechanical and optical alignment of fibers.

Each cable segment requires two strands of fiber: one to transmit data and one to
receive data. The ST-style connectors are used to connect the H4—EBC—F module
to a PC or a fiber optic hub or repeater.

Fiber Optic Cable The H4-EBC-F module accepts 62.5/125 multimode fiber optic (MMF) cable. The
glass core diameter is 62.5 micrometers, and the glass cladding is 125 micrometers.
The fiber optic cable is highly immune to noise and permits communications over
much greater distances than 10BaseT.

Fiber Optic Module Multimode Fiber Optic (MMF) Cable
ST Connector

Transmit

Transmit

Transmit

Receive Receive

Receive Connecting your fiber optic
62.5/125 MMF cable with EBC to a network adapter
bayonet ST-style connectors card or fiber optic hub

ﬁ% NOTE: See page 2-10 for 10BaseFL distance limitations.
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Maximum Ethernet Cable Length

The maximum distance per 10BaseT cable segment is 100 meters or 328 feet.
Repeaters extend the distance. Each cable segment attached to a repeater can be 100
meters. Two repeaters connected together extend the total range to 300 meters.

[

10BaseT Distance Limitations ]]

. \100 meters 100 meters
\@ (328 feet) (328 feet)
\
\

DEDD BEDE
100 - 100
meters meters
(328 feet) ™~ 100 meters ~ (328 feet)
! (328 feet) 1
" Between of
Repeaters Z
E

B o B A
0 0 0

The maximum distance per 10BaseFL cable segment is 2,000 meters or 6,560
feet. Repeaters extend the distance. Each cable segment attached to a repeater can be
2,000 meters. Two repeaters connected together extend the total range to 6,000 meters.

— 10BaseFL Distance Limitations SN
| :
A

2,000 meters 2,000 meters
\/ (6,560 feet) (6,560 feet)
J— 8888 8888
2,000 meters N g 2,000 meters
(?,560 feet) 2,000 meters \ (6,560 feet)
(6,560 feet)
Between
Repeaters
B B
8 o 8 o
0 0
© ©
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Calculating the Power Budget for the DL205 with H2-EBC

Managing your When determining which 1/0 modules you will be using in the DL205 EBC system, it

Power Resource is important to remember that there is a limited amount of power available from the
power supply. We have provided a table showing the power available from the
various DL205 base power supplies and a table showing the maximum power
consumed by the EBC and each of the I/0O modules supported by the EBC. Following
these two tables is an example of a completed power budgeting worksheet and then
a blank worksheet you can use for your own calculations.

If the 1/O modules you choose exceed the maximum power available from the
smaller DL205 base power supplies, you will need to use a D2—09B 9-slot base. This

base supplies more power than the other bases, as you can see in the table below. a
=
. . o)
§94 WARNING: It is extremely important to calculate the power budget. If you exceed 5
- O\ the power budget, the system may operate in an unpredictable manner which may =
result in a risk of personal injury or equipment damage.
EBC Power The following table shows the amount of electrical current available at the two
Specifications voltages supplied from the DL205 base. Use these values when calculating the
power budget for you system.
The Auxiliary 24V power source mentioned in the table is available at the base
terminal strip. You can connect to external devices or DL205 I/O modules that
require 24VDC, but be sure not to exceed the maximum current supplied.
Bases 5V Current Supplied Auxiliary 24VDC
Current Supplied
D2-03B 1550 mA 200 mA
D2-04B 1550 mA 200 mA
D2-06B 1550 mA 200 mA
D2-09B 2600 mA 300 mA
D2-03BDC-1 1550 mA None
D2-04BDC-1 1550 mA None
D2-06BDC-1 1550 mA None
D2-09BDC-1 2600 mA None
D2-03BDC-2 1550 mA 200 mA
D2-04BDC-2 1550 mA 200 mA
D2-06BDC-2 1550 mA 200 mA
D2-09BDC-2 2600 mA 300 mA
Module Power The chart on the next page shows the maximum amount of electrical current
Requirements required to power each of the DL205 EBC or I/O modules. Use these values when

calculating the power budget for your system.
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Power Consumption Chart (DL205 Modules)

Module 5V Power External Power Source Required
Required (mA)
CPUs
D2-230 120 None
D2-240 120 None
D2-250 330 None
DC Input Modules
D2-08ND3 50 None
D2-16ND3-2 100 None
ca D2-32ND3/-2 25 None
22 AC Input Modules
c=(§$ D2-08NA-1 50 None
D2 D2-08NA-2 100 None
= D2-16NA 100 None
DC Output Modules
D2-04TD1 60 20
D2-08TD1 100 None
D2-16TD1-2 200 24 VDC @ 80 mA max
D2-16TD2-2 200 0
D2-32TD1/2 350 0
AC Output Modules
D2-08TA 250 None
D2-12TA 350 None
Relay Output Modules
D2-04TRS 350 None
D2-08TR 250 None
D2-12TR 450 None
F2—-08TR 670 None
F2—-08TRS 670 None
Combination Modules
D2-08CDR 200 0
Analog
F2—04AD-1(L) 50 18-30 VDC @ 80 mA max; (-L) 10-15VDC @ 90mA
F2—04AD-2(L) 60 18-26.4 VDC @ 80 mA max; (-L) 10-15VDC @ 90mA
F2—08AD-1 50 18-26.4 VDC @ 80 mA max
F2-08AD-2 60 18-26.4 VDC @ 80 mA max
F2—-02DA-1(L) 40 18-30VDC @ 60mA; (L) 10-15VDC @ 70mA (add 20mA / loop)
F2—02DA-2(L) 40 18-30 VDC @ 60 mA max; (-L) 10-15VDC @ 70mA
F2-02DAS-1 100 18-32VDC @ 50mA per channel
F2-02DAS-2 60 21.6-26.4 VDC @ 60 mA per channel
F2-08DA-2 60 18-30 VDC @ 80 mA max
F2-04AD2DA 110 18-26.4VDC @ 80mA; add 20mA / loop
F2—04RTD 90 0
F2—04THM 110 18-26.4 VDC @ 60 mA max
Specialty Modules
D2-CTRINT 50 5 VDC @ 60 mA max (required for outputs only)
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Power Budget The following example shows how to calculate the power budget for the DL205
Calculation system.
Example
Base # Module Type 5 VDC (mA) Auxiliary
Power Source
1 24 VDC Output
(mA)
Available D2-09B 2600 300
Base Power
EBC H2-EBC + 530 + 0
Slot 0 D2-16ND3-2 + 100 + 0 =
Slot 1 D2-16NA + 100 + 0 &
Slot 2 D2-16NA + 100 + 0 %T’
Slot 3 F2-04AD-1 + 50 + 80 >
Slot 4 F2-02DA-1 + 40 + 100
Slot 5 D2-08TA + 250 + 0
Slot 6 D2-08TD1 + 100 + 0
Slot 7 D2-08TR + 250 + 0
Other
Maximum Power Required 1520 180
Remaining Power Available 2600-1520= 1080 | 300 — 170 = 120

1. Using the table on the previous page, fill in the information for the base
power supply, the EBC, 1/0 modules, and any other devices that will use
system power including devices that use the 24 VDC output. Pay special
attention to the current supplied by the base power supply. The 9-slot base
has a larger current capacity than the smaller bases.

2. Add the current columns starting with the row for Slot 0 and working your
way down to the “Other” category. Put the total in the row labeled
“Maximum power required”.

3. Subtract the row labeled “Maximum power required” from the row labeled
“Available Base Power’. Place the difference in the row labeled
“Remaining Power Available”.

4. If“Maximum Power Required’ is greater than “Available Base Power” in
either of the two columns, the power budget will be exceeded. It will be
unsafe to use this configuration, and you will need to restructure your 1/O.
You may need to a 9-slot base to accommodate your current requirements.
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Power Budget
Calculation
Worksheet

This blank chart is provided for you to copy and use in your power budget
calculations.

Base #

0

Module Type 5 VDC (mA) Auxiliary
Power Source
24 VDC Output (mA)

Available
Base Power

CPU Slot

Slot 0

Slot 1

Slot 2

Slot 3

Slot 4

Slot 5

Slot 6

Slot 7

Other

Total Power Required

Remaining Power Available

1.

Using the table on the previous page, fill in the information for the base
power supply, the EBC, 1/0 modules, and any other devices that will use
system power including devices that use the 24 VDC output. Pay special
attention to the current supplied by the base power supply. The 9-slot base
has a larger current capacity than the smaller bases.

Add the current columns starting with the row for Slot 0 and working your
way down to the “Other” category. Put the total in the row labeled
“Maximum power required”.

Subtract the row labeled “Maximum power required” from the row labeled
“Available Base Power’. Place the difference in the row labeled
“Remaining Power Available”.

If “Maximum Power Required” is greater than “Available Base Power”
in either of the two columns, the power budget will be exceeded. It will be
unsafe to use this configuration, and you will need to restructure your 1/O.
You may need to a 9-slot base to accommodate your current requirements.
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Calculating the Power Budget for the H4-EBC(-F)

Managing your
Power Resource

\//
/NN

Q

EBC and
Expansion Base
Power
Specifications

Module Power
Requirements

When determining which 1/0 modules you will be using in the DL405 EBC system, it
is important to remember that there is a limited amount of power available from the
power supply. We have provided a table showing the power available from the
H4-EBC and H4—-EBC-F or Expansion Unit power supplies and a table showing the
maximum power consumed by each of the 1/0 modules supported by the EBC.
Following these two tables is an example of a completed power budgeting
worksheet and then a blank worksheet you can use for your own calculations.

If the 1/0 modules you chose exceed the maximum power available from the power
supply you can resolve the problem by shifting some of the modules to an expansion
base which contains another power supply.

WARNING: It is extremely important to calculate the power budget correctly. If you
exceed the power budget, the system may operate in an unpredictable manner
which may result in a risk of personal injury or equipment damage.

The following chart shows the amount of electrical current available at the two
voltages supplied by the EBCs and Expansion units. Use these current values when
calculating the power budget for your system.

The Auxiliary 24VDC Power Source mentioned in the table is available at the

H4—-EBC terminal strip (see page 2—7). You can use this power source to connect to
external devices or DL405 I/0O modules that require 24VDC.

CPUs 5VDC Current Auxiliary 24VDC Power
Supplied in mA. Source Current
Supplied in mA.
H4-EBC 3470 400
H4-EBC-F 3330 400
Expansion Units 5VDC Current Auxiliary 24VDC Power
Supplied in mA. Source Current
Supplied in mA.
D4-EX 4000 400

The chart on the next page shows the maximum amount of electrical current
required to power each of the DL405 I/0O modules. Use these values when
calculating the power budget for your system.
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7
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=
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Power Consumption Chart (DL405 Modules)

Device 5V Current External 24V Device 5V Current External 24V
Required (mA) Current Req. (mA) Required (mA) Current Req. (mA)
1/0 Bases AC Output Modules
D4-04B, D4-04BNX, | 80 None D4-08TA 250 None
D4-04B-1
D4-06B, D4-06BNX, | 80 None D4-16TA 450 None
D4-06B-1
D4-08B, D4-08BNX, | 80 None Relay Output Modules
D4-08B-1
_5 % DC Input Modules D4-08TR 550 None
E g D4-08ND3S 100 None F4-08TRS-1 575 None
-'g '8 D4-16ND2 150 None F4-08TRS-2 575 None
= D4-16ND2F 150 None D4-16TR 1000 None
D4-32ND3-1 150 None Analog Modules
D4-32ND3-2 150 None D4-04AD 200 200
D4-64ND2 300 (max) None F4-04AD 85 100
AC Input Modules F4-04ADS 270 120
D4—-08NA 100 None F4-08AD 75 90
D4-16NA 150 None D4-02DA 250 300
AC/DC Input Modules F4-04DA 120 180
D4-16NE3 150 None F4-04DA-1 70 75 + 20 per circuit
F4—-08NES 90 None F4-04DA-2 70 75 + 20 per circuit
DC Output Modules F4—-08DA-1 70 100 + 20 per circuit
D4-08TD1 150 35 F4-16DA-1 70 100 + 20 per circuit
F4-08TD1S 295 None F4-08THM-n 120 50 + 20 per circuit
D4-16TD1 200 125 F4-08RTD 80 None
D4-16TD2 400 None Specialty Modules
D4-32TD1 250 140 D4-HSC 300 None
D4-32TD1-1 250 140 (5-15VDC) D4-16SIM 150 None
D4-32TD2 350 120 / (4A max
including loads)
D4-64TD1 800 (max) None
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Power Budget The following example shows how to calculate the power budget for the DL405
Calculation system.
Example
Base # Auxiliary
Module Type 5 VDC (mA) Power Source
1 24 VDC Output (mA)
EBC/ H4-EBC 3470 400
Expansion
Unit
Slot 0 D4-16ND2 + 150 + 0
Slot 1 D4-16ND2 + 150 + 0
Slot 2 D4-02DA + 250 + 300 5
Slot 3 D4-08ND3S + 100 + 0 &
Slot 4 D4-08ND3S + 100 + 0 %
Slot 5 D4-16TD2 + 400 + 0 >
Slot 6 D4-16TD2 + 400 + 0
Slot 7 D4-16TR + 1000 + 0
Base D4-08B + 80 + 0
Other
Maximum power required 2630 300
Remaining Power Available 3470-2630 = 840 | 400 — 300 = 100

1. Using the table on the previous page, fill in the information for the
EBC/Expansion Unit, /0O modules, and any other devices that will use
system power including devices that use the 24 VDC output. Pay special
attention to the current supplied by the H4-EBC, the H4—EBC-F or the
Expansion Unit. Each one supplies a different amount of current.

2. Add the current columns starting with the row for Slot 0 and working your
way down to the “Other” category. Put the total in the row labeled
“Maximum power required”.

3. Subtract the row labeled “Maximum power required” from the row labeled
“‘EBC/Expansion Unit’. Place the difference in the row labeled
“Remaining Power Available”.

4. If “Maximum Power Required” is greater than “EBC/Expansion Unit” in
either of the two columns, the power budget will be exceeded. It will be
unsafe to use this configuration, and you will need to restructure your 1/0.
You may need to add expansion bases to accommodate your current
requirements.
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You may copy and use the following blank chart for your power budget calculations.

Base #

Module Type 5 VDC (mA) Auxiliary
Power Source
24 VDC Output (mA)

EBC/

Expansion

Unit

Slot 0

Slot 1

Slot 2

Slot 3

Slot 4

Slot 5

Slot 6

Slot 7

Base

Other

Maximum Power Required

Remaining Power Available

Using the tables at the beginning of the Power Budgeting section of this
chapter fill in the information for the EBC/Expansion Unit, I/O modules, and
any other devices that will use system power including devices that use the
24 VDC output. Pay special attention to the current supplied by the
H4-EBC, the H4—EBC-F or the Expansion Unit since they do differ.

Add the current columns starting with the row for Slot 0 and working your
way down to the “Other” category. Put the total in the row labeled
“Maximum power required”.

Subtract the row labeled “Maximum power required” from the row labeled
“‘EBC/Expansion Unit’. Place the difference in the row labeled
“Remaining Power Available”.

If “Maximum Power Required” is greater than “EBC/Expansion Unit” in
either of the two columns, the power budget will be exceeded. It will be
unsafe to use this configuration, and you will need to restructure your 1/O.
You may need to add expansion bases to accommodate your current
requirements.
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DL405 Local and Expansion I/O

The H4-EBC supports the use of DL405 series I/O local and local expansion bases.

Local Base and I/O The local base is the base in which the
EBC resides. Local /0O modules reside in
the same base as the EBC. For example,
placing 32-point modules in all eight slots
in an 8-slot base will use 256 1/O points .

16pt | 8pt | 32pt | 16pt | 8pt | 16pt
Input | Input | Input {Output | Output||Output

[¢]

Local Expansion Use local expansion bases when you need more I/O points or a greater power

Base and I/0 budget than the local base provides. The expansion bases require a Local
Expansion Unit (rather than an EBC) and a cable (either D4-EXCBL-1 or
D4-EXCBL-2) to connect to the local EBC base.

The following figure shows one EBC base and three expansion bases. The 1/O
modules are shown as examples of a usable configuration, but any configuration of
I/0 modules could be used if it is supported by the power budget. See page 2—15 for
information about calculating the power budget.

The H4—EBC supports one local base and a maximum of three expansion bases.

o =
S @
Qo
DS
Q=
[

s S

O s

E

expansion bases.

The H4-EBC(-F) QY —~ —
supports up to three 45X 405EX
0 o




Configuring the EBC
Using NetEdit

In This Chapter. . ..
— Starting NetEdit Software
— Using NetEdit
— Using NetEdit to Configure the DL405 Base
— Locating the Ethernet Address Label
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Starting NetEdit Software

Operating System NetEdit is a software utility which can be used to select the Ethernet communication

Requirements

System
Requirements

The NetEdit
Screen

protocol, to set the Module ID for the EBC, and to perform diagnostic and
troubleshooting tasks. It can also be used to configure the serial port and to
configure the DL405 base.

You can run NetEdit on Windows 95/98™, Windows NT™, or Windows 2000™,
Windows ME™ . NetEdit will run directly from your 3.5” floppy disk drive.

To run the NetEdit program, [y |
insert the NetEdit 3.5” floppy

disk m'_[o dr'ye A: (Or the Type the name of a program, falder, or docurent, and
appropriate drive for your PC). Windaws will open it for you.

Click on the Start button and

selct Run...from the pop-up | Geen | [EATTEIESH I
window, enter the letter of the I | B Separate Memon Space

drive, colon, backslash and the

name NetEdit, and click OK. Dk I Cancel | Browse... |

If you prefer, you can copy the NetEdit files from the 3.5” floppy disk to your hard
drive. In Windows Explorer, locate the following three files on the floppy disk:

e Hei32_2.dll
e Netedit.exe
e Netedlib.dll

Copy all three files to a single directory on your hard drive, and start NetEdit by
double clicking on NetEdit.exe.

Starting NetEdit brings up the screen below. All NetEdit functions are accessed from
this screen.

iu PLCDirect - NetE dit ||

— Protocol————— — Module Information — Configuration

= IPK Type:  H4EBC Module1D: |7 =
© UDPAP ior: [
Mersion: |2.1.1 Mame: |FCBC 405EBC

—Module————— —Ethemet Stats———— | Description:

405 Ethernet Baze
Controller,

00 EQ 62 40 00 AC

Migsed Frames: |EI
T Collisions

Lozt Packets:

’07
’07

Bad Packets: ’07 IP Address:
’07
’07

|255 |255 |255 |255
Unknown Type:

Send Errors; Update |

Guerny Metwork Clear Stats Advanced Settings. .. |

Exit |
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Using NetEdit

In this section, we will step through the features and uses of NetEdit. We will describe
the individual segments of the NetEdit screen and the function of each. If you need to
refer to the full screen, you can start NetEdit as described on page 3-2, or you can
refer to the figure at the bottom of page 3-2.

= module. If so, please refer to the appropriate documentation for that software
= product to determine the best method to configure the EBC. The use of Think & Do
software to configure the EBC is discussed in Appendices B and C of this manual.

[_ NOTE: Your PC-based Control software may be capable of configuring the EBC

Ethernet In the upper left corner of the NetEdit screen, you will find a box labeled Protocol. In

Communication the box, there are two choices: IPX and UDP/IP. The EBC module understands IPX

Protocol and UDP/IP protocols. Both protocols are permanently resident in the firmware of
the module.

When you click on one of these radio buttons, you are selecting the protocol you
want your PC to use to communicate with the EBC module. You are not telling the
module which protocol to use, because it is using both protocols all the time. IPX is a
Novell standard in widespread use, and UDP/IP is a popular protocol supported by
the TCP/IP suite of protocols in your PC.

The figure to the right shows the

Protocol selection box in the upper left mi PLCDirect - NetE dit

corner of the NetEdit screen. The

choice you make here tells your PC ~ Protocal Module
which protocol to send to the EBC to 'O ,

: . P Tupe
link NetEdit to the module. You are not '
selecting which protocol the EBC ™ UDPAP Wersior
understands. It understands both.

Some PC-based control software - Module ||_E“'
products may support only one of ODEOBZ 2000 20 '
these protocols. Read the |DD EQE22znm =7
documentation for your software to be
sure the protocol you select is
supported.

PLC links. Use UDP/IP in your application, if required, but also add IPX to your list of

om0 NOTE: We strongly recommend you load IPX protocol on your PC and use it for your
[E active protocols. Having IPX loaded on your PC gives you a backup for

troubleshooting communication problems.
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Adding Network You may have already set up your PC with selected networking protocols for

Protocol Support Ethernet communications. If not, you will need to select the protocols now for

to Your PC communication with the EBC module. We strongly recommend that you include the
IPX protocol. From My Computer on your PC Desktop, go to Control Panel. Double
click on Network, then click on the Protocols tab. If IPX is not listed among the
protocols already loaded, add it now by clicking on the Add... button. The Select
Network Protocol window will pop up (see figure below).

Add the TCP/IP protocol if it is necessary for your application. The TCP/IP selection

will give you support for the UDP/IP protocol. Also, add the IPX protocol if it is not
already active.

Select Network Protocol EHE |

Click the Metwark Protocal that you want to inztall, then click OF. 1
=E3= wou have an inztallation dizk for thiz component, click Have Disk.

Metwork, Frotocal;

™ NetBEUI Frotocal =]
— - MLk ISP Compatible Transport

" Paint To Paint Tunneling Protocol

W Streams Environment
— W TCPAP Protocol

-

Hawve Dizk.. |
(] I Cancel |

Ethernet Address The lower left corner of the NetEdit
screen displays the  Ethernet |
Address of the modules currently on

—Module————— =

the network.
00 E0 B2 40 00 AC M

If modules are added or removed from :
the network, click on the Query T
Network button to update the list.
Notice that the Ethernet Address is the Lost|
factory-assigned address that is on the Bad P:
permanent label on the module. See
page 3-8. Urkria
Select a specific module here by SendEl
clicking on the Ethernet Address or by
using the arrow keys. The selected Elep (elmas
module is highlighted.

[E NOTE: The Module box lists the Ethernet Addresses of Ethernet Base Controllers

= (EBCs) and Ethernet Communications Modules (ECOMSs). This manual covers the

use of NetEdit for assigning a Module ID to EBCs only.
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Module The Module Information box gives the e e
Information Type and the Version number. The Type is :
the catalog number of the module. The Madule Infarmtin :
Version refers to the firmware version. Type:  |H4EBC b
This box is in the top middle of the NetEdit Wersion: |21.1
screen.

NOTE: The module information and settings on this page apply to the selected
(highlighted) module. To select a module, click on its Ethernet Address in the Module
box. See page 3—4 for more information about selecting a module.

The Ethernet Stats are statistics related to . Ethemet Stats
communication errors. These statistics are

explored in Chapter 4, Maintenance and Missed Frames: |0
TrOUbleShOOting. T Callisianz ]

Click on the Clear Stats button to reset all

. Lost Packetz: |0
categories to 0 (zero).

Bad Packets: 0

Module ID The Configuration box allows you to Unknown Type: |0
assign a Module ID. Module IDs must be end Enors |00
unique for each EBC, but they do not have '
to be in sequence. The DIP switches must Clear Stats
all be set to zero to enable any software to
change the Module ID. Do not use

address zero for communications. |

The Name field and Description field are || [ Senfigurstien

optional. | Moddep: |9 =

To set an IP Address, highlight the Name: |P|:E=|:4c|5EB|:
number in each of the four boxes, and

T

overwrite the number. Use the = | Description:
twelve-digit number assigned to the EBC é”uitf;h‘:rme‘ Base
module by your network administrator. If '

you change the IP Address, do not use the

number “255” in any field. Doing so will Ao

cause communication problems.

|255 |255 |255 |255
The Update Module button sends all
entries to the module’s flash memory. The Update |
Advanced Settings button displays a
pop-up window described on the next

page.

Advanced Settings. . |
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Advanced The Advanced Settings button in the Configuration box of Net Edit (page 3-5)
Settings brings up the EBC Advanced Settings window.
Clicking on the Serial Port button (right)
causes the Serial Port Settings screen to EBL Advanced Settings |
pop up.
Serial Port...

Clicking on the Base Configuration button
causes the EBC Base Configuration

Baze Configuratian...
screen to appear.

E xit

On the Serial Port Settings screen, make Serial Port Settings =
any necessary changes to the serial
communication parameters. After making

— Azuhc Settings
9500

changes, be sure to click on the Update Baud Rate:
Module button. Also, Be sure these _ m
parameters match the parameters of the Data Bits:
serial device with which you are e |
communicating. tap St
P arity: Odd b
Note: Some PC-based Control software
— Port Mode

packages may automatically overwrite
settings selected here. Refer to the
documentation for your PC-based Control |

% Slave " Master

software. Ipdate Module
| Exit |
H4-EBC Base Configuration 1]
The DLA0G architecture does not provide To allow for proper operation of your Left-click the buttan(z] cormesponding to
the H4-EBC with enough information to analog modules, pleaze uze the matris the location of pour analog modulez] to
disgtinguizh between Dizcrete [/0 modules  below to describe the twpe and placement  cycle thiough the optionz, OF right-click
and Analog 170 modules. of any analog modules to the H4-EBLC. on each button to zelect from a menu of
options,

Slat 0 Slat 1 Slat 2 Slat 3 Slat 4 Slat 5 Slat B Slat 7
el e || mme— | mme— || e Enpty Ermipty Empty Ermpty
Baze 1 Bty Empty Ermpr Ermph ity Bty Empty Ermpr
Baze 2 Bty Ermnpti Ermpt Bt ity Bty Ermnpti Ermpt
Baze 3 Erripty gty =gty Erpty Erripty Erripty gty =gty

Update Module |

When you click on the Base Configuration button (top of page) the H4—EBC Base
Configuration screen pops up, as shown (immediately above). The H2-EBC is
self-configuring and does not require this step.
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Using NetEdit to Configure the H4—-EBC Base

NOTE: The following configuration information applies only to the H4—EBC(—F) and
the DL405 1/0. The H2-EBC(—F) and associated DL205 I/O are self-configuring and
do not require this additional step.

The default symbol “---------- ” appears on the configuration screen where digital or
analog modules are present. For digital modules, you do not need to make any
changes. The H4—EBC recognizes the digital modules and is self-configuring for the
digital modules.

If you are using analog modules, you must let the H4—EBC know that by doing the

following. Click on the slot location where the analog module is located. Continue
clicking on the same slot location until the part number of your analog module

appears.

Configuri ng H4-EBC Base Configuration
Analog Modules

The DL40S architecture does nat provide  To allow for proper operation of waur Left-click the buttan(z] comezponding ta

the H4-EBLC with enough infarmation to analog modules, pleaze use the matrix the location of pour analog module(s] o

digtinguish between Dizorete /0 modules  below to describe the type and placement  cycle through the options, OR right-click

and Analog |/0 modules. of any analog modules to the H4-EEC, on each button to zelect fram a menu of

optionz.
Slot 0 Slot 1 Slat 2 Slat 3 Slat 4 Slat & Slat & Slat 7

BaseD - | e FA-08RTD F4-0404-n

Baze 1

Baze 2

Baze 3

Esit |

Once the correct part numbers appear for each of your analog modules, click the
Update Module button to save the configuration into flash memory onboard the
module. Leave the symbol “---------- ” wherever you have a digital module.

If you are using a High Speed Counter module, the word “Intelligent” will appear in
gray. The High Speed Counter module is configured automatically (see below). No
other action is required other than clicking on the Update Module button.

Cpnfiguring the H4-EBC Base Configuration
High Speed
Counter Module The DLA0S architecture doss not provide To allove for proper operation of paur Left-click the button(s] comesponding to
the H4-EBLC with enough information to analog modules, pleasze uge the matn the location of your analog module(z] to
digtinguish between Discrete [0 modules below to describe the twpe and placement  cycle thiough the optionz, OF right-click
and Analag /0 modules. of any analog modules ta the H4-EBC. on each button to select fram a menu of
optionz.
Slot 0 Slat 1 Slat 2 Slat 3 Slat 4 Slat b Slat & Slat 7
Basel e | e F4-04405
Baze 1
Baze 2
Baze 3
Update Module
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Locating the Ethernet Address Label

Factory-assigned Ethernet Address

Host Auto Prod
Host Auto Prod H4-EBC

H2-EBC 00 EO0 62 00 00 85
00 E0 62 00 00 84

|

Ethernet Address A unique Ethernet Address is assigned to each module at the factory and cannot be
changed. ltis a twelve digit number, and it is printed on a label permanently attached
to the EBC module. NetEdit recognizes the Ethernet Address




Troubleshooting

In This Chapter. . ..

— Isolating a Communication Problem
— Troubleshooting Chart

— EBC Module Diagnostic LEDs

— Using NetEdit for Troubleshooting
— Diagnosing Network Cable Problems
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Isolating a Communication Problem

If you are experiencing a problem communicating with an EBC module, the problem
can usually be isolated to one of four components of the communication link:

o the EBC module itself (hardware or firmware)
e the communication program or the setup of the EBC module
e the cabling and connections

e other external influences, such as electrical noise, heavy communication
traffic on the network or exceeding the PLC power budget

Diagnostic Tools  Several available tools and techniques can help you isolate a communication
and Techniques problem:

e The LEDs on the face of the module indicate the status of the link, the
module, and the network communications.

e Replacing the module may determine whether the problem is in the
module.

o NetEdit displays a list of the active modules on the network and their
protocol and configuration settings.

e Cable testing devices can pinpoint short or open circuits or diagnose
attenuation problems and other cabling problems.

e Diagnostic tools within your PC-based Control software.

Troubleshooting Chart

The following chart summarizes the different types of communication failures you
could experience. In each case the CPU PWR LED must be on, and you must be
attempting to communicate with the EBC in question.

The meaning of the diagnostic LEDs is explained on page 4-4.

Troubleshooting Chart
Legend: ] Off Il On Flash
EBC Module LEDs Corrective Action

Guidelines

o
c
£
(]
o
<
%)
Q
o
=
o
—
|_

1. Cycle power to the base. This will clear

LINK(?TD g OR LINKSITD g the ERROR if it was due to a transient
ERROR I ERROR condition.

2. Replace EBC module
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Troubleshooting Chart (Continued)

Legend: 1 Off HEE On Flash

EBC Module LEDs Corrective Action

1. Try another cable that you know works.

LINKGD [ Check pinouts (see page 2-8).
ACT [ 2. Try another port on the hub or
ERROR [ another hub.

3. Replace EBC module.

1. Try another cable between PC and hub.
2. Try another port on the hub or another

hub.
LINKGD 3. Make sure you have not exceeded the
ACT [ recommended cable length for your
ERROR [ network cable. The link signal could

arrive with sufficient strength even
though the data transmission does not.

4. Could be related to Windows configura-
tion. Consult Windows documentation.

Note: This is also the indication of proper
operation! Troubleshoot only if you are
failing to exchange data.

1. Try another cable between PC and hub
or EBC and hub.

=

oL

LINKGD Il LINKGD Il 2. Try another port on the hub or another co
ACT OR  ACT mm hub. &2
=3

ERROR [ ERROR [ 3. Look for errors in the setup of the EBC a 3
n=

@

module.
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Guidelines

o
c
£
(]
o
<
%)
Q
o
=
o
—
|_

EBC Module Diagnostic LEDs

EBC LEDs

LINKGD [

ACT [
ERROR [

LINK GOOD
Indicator

ACTIVITY Indicator

ERROR Indicator

The EBC module has three indicator lights which show the status of the following:
e signal path between the EBC and the hub
e signal between a PC and an EBC
e EBC module hardware

H2-EBC H4-EBC

110/220VAC
POWER LINK GOOD
ERROR ACTIVITY

RELAY BATT LOW

LINK GOOD
ERROR ACTIVITY

The green LINKGD (LINK GOOD) LED is on steady when the EBC module is
connected properly to an active device on the network and is receiving 5VDC
operating voltage from the PLC power supply. The LINKGD LED verifies that the
proper cables are connected, and the EBC module is functioning correctly. If a
mismatch with the 10BaseT or 10BaseFL connections occurs this LED will not be
illuminated.

The red ACT (ACTIVITY) LED flashes to indicate that the module is detecting data
on the network. If any network device is sending or receiving data, the ACT LED will
be illuminated. In idle mode (no network traffic) this LED is OFF. During heavy
communication loads this LED will be on steady.

If the EBC module’s red ERROR indicator is flashing or on steady, a fatal error has
occurred. The error may be in the EBC module itself, or a network problem may be
causing this symptom. The ERROR indication can be caused by a faulty ground, an
electrical spike or other types of electrical disturbances. Cycle power to the system
to attempt clearing the error.
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Using NetEdit for Troubleshooting

NetEdit is a software utility which came with this manual. To review the procedures
for running and using NetEdit, see Chapter 3. NetEdit allows you to:

e See active modules on the network.

e Examine and change the modules’ configuration settings.

e See the firmware revision number.

o Review statistical information about communication errors by type.

Select a Module The Module box shows the Ethernet
Addresses of all modules which are |
currently linked to the NetEdit utility. If your

EBC module is not on this list, try the ~ Module B
following: 00 EQ B2 40 00 AC M
e Change Protocol selection and click on T,
Query Network. See Change
Protocol on the next page. Last
e Confirm that your PC has IPX or Bad P:
TCP/IP protocol loaded.
ik
e Confirm that the EBC module’s Link
Good LED is on. =end Ei
Cluery Mebworl:
= NOTE: The Ethernet Address is permanently assigned at the factory, and it is
= recorded on a label on the side of the EBC module. See page 3-8 if you need help
— locating the label.
=
oL
co
89
. : : : ... =:
Module Information The Module Information box is updated with 53
module type and version for the module Module Information L 2
currently selected. Verify that all modules Type:  |H4EEC b @

of the same type (H2 or H4) have the same

firmware version. Wersion: |2.1.1
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Guidelines

o
c
£
(]
o
<
%)
Q
o
=
o
—
|_

Change Protocol

Ethernet Stats

Replacing the EBC
Module

\Vd
o—
/NN

If you are experiencing a problem Protacal
communicating from your PC to a module Fetaco
that does not appear on the list of active [l |=;
modules, try changing the protocol and

clicking on Query Network. You may be o |UDP/P
able to link to your module with the other

protocol.

If you are not sure which protocol driver is loaded on your PC, refer to page 3—4, as
well as your Windows NT™ documentation.

If you are able to see the problem module on
the list of modules currently active on the
network, you can select the module to see
the Ethernet Stats for that module. Select
the module by clicking on the Ethernet
Address in the Module box (see page 3-4).

To begin a new statistical record, click the
Clear Stats button.

The diagnostic information available in the
Ethernet Stats box is:

— Ethernet Stats
Mizzed Frames: |B
T Callisions 1
Lost Packets: |11
Bad Packetz: |0

Unknown Type: |0

AR

Send Errors: ]

e Missed Frames — frames lost Clear Stats

due to unavailability of buffer
space.

e TX Collisions — detected when
RXD+ and RXD- become active during a data transmission. Two
devices are trying to communicate at the same time.

e Lost Packets — packets that overflow the queue.

o Bad Packets — packets that fit the Ethernet standard but are not in the
right format for the EBC module.

¢ Unknown Type — a foreign command was received and could not be
interpreted. This will probably happen only during software driver
development.

o Send Errors — the Ethernet standard number of retries were attempted
for a transmission.

If you are replacing an existing EBC module with a new one, you need to set up the
new module with the same Module ID as the module you are replacing. If you used
the DIP switch to set the Module ID, you will need to set the DIP switch on the
replacement module to the same Module ID. See page 2—-3 or 2—4 to review the
procedure for setting the Module ID using the DIP switch.

If you set up your original EBC module using NetEdit, you will need to duplicate the
settings in the new module using the same procedures. See page 3—-2 through 3-7
to review the procedures for using NetEdit.

If you set up your original EBC module using your PC-based Control software, you
will need to refer to the appropriate documentation.

WARNING: Your system can be damaged if you install or remove system
components before disconnecting the system power. To minimize the risk of
equipment damage, electrical shock, or personal injury, always disconnect the
system power before installing or removing any system component.
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Diagnosing Network Cable Problems

If you are experiencing communication problems, swapping cables is one of the
simplest diagnostic procedures you can perform. If the network operates correctly
with a different cable, you have isolated and cured the problem. If possible, use a
short run of cable to test the network because problems with longer cable runs can
be more difficult to diagnose and are more often intermittent.

If you are unable to swap cables, verify the proper operation of all other network
components. You probably have a cable problem if you have verified that your:

e EBC module is working correctly.

e EBC module configuration is correct.

e RLL program or PC program is correct.

e hubs are working correctly.

e Windows configuration is correct.

e network adapter card is the correct type, and it is working correctly.

It is a good maintenance practice to test network cables periodically and maintain a
permanent record of cable characteristics. A number of cable test instruments are
available to test 10BaseT and 10BaseFL networks. These instruments will check the
electrical or optical characteristics of your cabling, including:

o Continuity — This is a check to make sure the communication pairs are
wired correctly, and that the wires are continuous from end to end. In the
case of fiber optic network this is a test to be sure light is transmitted
from one end of the cable to the other.

e Attenuation — This refers to the amount of signal loss over the cable
segment at the signal frequency of interest. The 10BaseT specification
allows for a maximum signal loss of 11.5 decibels (dB) for the entire link
at the signal frequency used by 10Mbps Ethernet. The 10BaseFL
specification calls for the optical loss in link segment to be no greater
than 12.5 dB.

e Crosstalk — Crosstalk occurs when a signal in one pair of wires is
electromagnetically coupled to an adjacent pair. This is critical
for10BaseT networks which are susceptible to noise interference.
10BaseFL networks are virtually immune to noise interference.

NOTE: Any significant difference between the cable characteristics of the
transmitter and receiver can cause communication errors.

Ethernet devices continually monitor the “receive data” path for activity as a means
of verifying their link is working correctly. When the network is idle, each network
device (including the EBC module) sends a periodic link test signal to verify that the
network is working. If the link test signal or other network activity is not received
periodically, the Link Good LED on the EBC module is turned off.

()
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Appendix A
General
Specifications

In This Appendix
— H2-EBC(-F) and H4-EBC(—F) Specifications
— Serial Port Specifications
— Ethernet Standards
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H2-EBC(-F) and H4-EBC(-F) Specifications

<
X
©
c
o)
Q
Q
<

Link Distance
Ethernet Port
Ethernet Protocols
Serial Port

Power Consumption
Manufacturer

100 meters (328 ft)
RJ45

TCP/IP, IPX

RJ12, K-sequence
530mA

Host Automation Prods

Specifications H2-EBC H2-EBC-F
Communications 10Base-T Ethernet 10Base-FL Ethernet
Data Transfer Rate 10Mbps 10Mbps

2,000 meters (6,560 ft)
ST-style fiber optic
TCP/IP, IPX

RJ12, K-sequence
670mA

Host Automation Prods

Link Distance
Ethernet Port
Ethernet Protocols
Serial Port

Power Supplied

Manufacturer

100 meters (328 ft)
RJ45

TCP/IP, IPX

RJ12, K-sequence
3470mA @ 5VDC
400mA @ 24VDC
Host Automation Prods

Specifications H4-EBC H4-EBC-F
Communications 10BaseT Ethernet 10BaseFL Ethernet
Data Transfer Rate 10Mbps 10Mbps

2,000 meters (6,560 ft)
ST-style fiber optic
TCP/IP, IPX

RJ12, K-sequence
3330mA @ 5VDC
400mA @ 24VDC
Host Automation Prods

Serial Port Specifications

Serial Port Pin Descriptions

ov Power (=) connection (GND)
5V Power (+) connection

RXD
TXD

Receive Data (RS232C)
Transmit Data (RS232C

RTS

o O Wi =

Request to Send
oV Power (=) connection (GND)

6-pin Male (RJ12)
Modular Plug

123456

6-pin Female (RJ12)
Modular Jack
as oriented on EBC

)
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Ethernet Standards

Various institutes and committees have been involved in establishing Ethernet data
communication standards. These specification standards assure Ethernet network
compatibility for products from a broad variety of manufacturers.

The EBC module complies with  American National Standards Institute (ANSI) and
Institute of Electrical and Electronic Engineers standard ANSI/IEEE 802.3, Carrier
Sense Multiple Access with Collision Detection (CSMA/CD) Access Methods and
Physical Layer Specifications. This standard has been adopted by the International
Organization for Standardization (ISO) as document ISO/IEC 8802-3.

The Electronic Industries Association (EIA) and Telecommunications Industries
Commercial Building Telecommunications Wiring Standard designated
EIA/TIA-568A defines implementation of 10BaseT (twisted pair) and 10BaseF
(fiber optics) for Ethernet communications.

The same two organizations produced EIA/TIA TSB40-Additional Transmission
Specifications for Unshielded Twisted-Pair Connecting Hardware. The purpose of
this document is to specify transmission performance requirements and connecting
hardware requirements.
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Appendix B
Using the H2-EBC
with Think & Do

In This Appendix. . . .
— Configuring the DL205 I/O Base
— Mapping H2-EBC I/O Points
— Analog Output Module Setup
— 1/O Module Status Words / Bits
— Using EZTouch/EZText Panel with the RJ-12 Serial Port
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Configuring the DL205 I/O Base

The H2-EBC(—F) and DL205 I/O are self-configuring. The H2—-EBC(—F) reads the
module and identities it on powerup. Within the Think & Do I/O View tool, the DL205
I/O modules are graphically displayed as soon as a connection is established
between your PC and your H2—-EBC(—F).

For additional information about establishing a connection between your PC and the
H2—-EBC(-F), please see the Think & Do Software Learning Guide.

Mapping H2-EBC 1/O Points

We recommend that you be familiar with “Getting Started” and “Creating a Project”
chapters in the Think & Do Studio Learning Guide before attempting to map the
EBC 1/0O points/channels to Data Items using ConnectivityCenter.

Launching To launch ConnectivityCenter:

Connectivity 1) Launch Think & Do Studio ProjectCenter from the Windows desktop by either
Center Tool clicking on Start, then Programs, next Think & Do Studio, finally
ProjectCenter or click on the ProjectCenter icon to start.
2) Click on the File Menu and either open your Think & Do Project or select New.
3) Within ProjectCenter select Windows 2000 or NT Certified PC as the Runtime
Target.
4) Then either click Tools, then ConnectivityCenter to launch the
ConnectivityCenter or click on the ConnectivityCenter shortcut in the Project
Explorer.
5) Once in ConnectivityCenter click on Drivers, then Add and select
Automationdirect.com Ethernet I/O Driver.
5)Then either click on Configuration, then Connect or click on the Connect
toolbar button.
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Connecting ConnectivityCenter will draw a picture of your EBC 1/O system.
to the EBC
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Mapping I/O Points This procedure is discussed in detail in the “Creating a Project” chapter in the Think
to Data Items & Do Studio Learning Guide. This will map your real world 1/O to Data Items.
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1/0 Module Status Word / Bits

I/O Module diagnostic information is listed for each 1/0O module under the Module
Status Mapping tab. Click on a module graphic to display its Status Item

Descriptions.
Status Indicator
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Using EZTouch/EZText Panel with the RJ-12 Serial Port

The H2—EBC has a built—in RS232C serial port that can be used to connect to an
operator interface panel. Use ConnectivityCenter to configure the connection from
the H2—EBC to the EZTouch or EXText panel. The “HMI Options for Remote Base
Controllers” section in the “Operator Screen Techniques” chapter in the Think & Do
Studio Learning Guide discusses configuring and using Optimate Panels with the

EBC.
% Adding Operator Click on the H2—EBC graphic and Module Info tab in the ConnectivityCenter. The
il Interface Device Serial Port Settings attributes are all that will be visible in ConnectivityCenter when
o = the 1/0 is disconnected. Follow the steps below to configure the EBC’s RJ12 serial
X 3 port to be used with either the EZTouch or the EZText panels.
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1. Click Here to access port settings.
2. Check Enable Serial s T
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Using Monitor I/0
to Verify Panel
Operation

Monitor 1/0
Dialog Box™

Once the EZTouch or EZText panel has been added, it will show up in the list of the
configured devices, and an EZTouch/Text panel graphic symbol will be located
under the 1/0O base next to the EBC.
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Re—connect to the I/O in ConnectivityCenter by either clicking on Configuration,
then Connect or by clicking on the Connect toolbar button. Then scan the 1/O by
either clicking on Configuration, then Scan or by clicking on the Scan toolbar
button. Doubleclick on the EZ panel box graphic to launch the Monitor 1/0 Dialog
Box. The Monitor I/O tool allows the user to update the fields at any moment, altough
the panel continuously updates the fields with changes as well. All of the “Value”
fields in the Monitor 1/0 Dialog Box are read/write and are updated from the the
Monitor 1/0O Dialog box which takes precedence over updates from the panel.
The user can update bit values (Input, Output and Flag) immediately by one mouse
click or by pressing the space bar.

When typing in numbers, the grid will enter the edit mode which will block any
conflicting updates from the panel. The edit mode entry is completed after pressing
Enter, any arrow key or by selecting a new line.
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Appendix C
Using the H4-EBC
with Think & Do

In This Appendix
— Configuring the DL405 |/O Base with H4-EBC(—F)
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Configuring the DL405 I/O Base with H4-EBC(-F)

Configuring the base is a necessary step in the setup of the H4—EBC module. The
H4—-EBC must know the type and location of each input and output module installed
in the base. Once identified, the configuration resides in non-volatile memory
on-board the EBC until a change is made.

The H4—-EBC is partially self-configuring. On powerup, the H4-EBC reads the base
to determine the specifications of installed modules. The information available
allows the H4—-EBC to determine:

e whether the I/0O modules are inputs or outputs

e whether the installed modules are standard /O modules or a High

Speed Counter module (other intelligent modules are not supported at
this time)

If you are not using analog inputs or outputs the H4—EBC configures itself. For the
following module types, the DL405 I/O system provides the necessary configuration
information to the H4—EBC, and the H4—EBC automatically configures the base:

o digital inputs
o digital outputs
e High Speed Counter module

If you are using analog inputs or outputs you must configure the base manually
using a software utility imbedded in Think & Do:

o
(=]
|_
c
O.":'
2m
O W
23
< T
o
£
7]
-]

You are ready to configure your base if you have done all of the following:
e installed your H4—EBC or H4—EBC—-F module
e connected power wiring to the EBC terminal strip

¢ installed I/O modules and expansion bases as necessary for your
application

e connected your PC and EBCs to a dedicated Ethernet network
e installed Think & Do (Version 4.4, or later) on your PC

o NOTE: The pages that follow explain how to use the Think & Do software utility for
!g configuring the base. For additional information about using the Think & Do software
— product, please refer to the Think & Do Software Learning Guide.
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Starting 1/0 View I/O View is one of the tools provided by Ep—
Think & Do software. It is directly accessi- B b
ble from the Start menu after installation. & el
Select Start, then Programs, then Think [y rrrr——
& Do, then T&D I/O View, as shown to the CHTTRETIRD
right.
4 Alem Diesigner Product Inko
Gp README
[=RETS
50 10w h;
T80 Propectlnmbes
K@l 150 Run Tane
£} Think & Do AMIGOS
The 1/0O View window will appear as Emxm

Configuiation Wiew Tooks Help

shown, with a blank I/O configuration
screen. If you save this screen without
renaming it, the default name will be
“IOView1”.

Dl=E] = =3e] ez
o B T

We use a new |/O View window to
configure the 1/O for an example system.
The H4-EBC is connected to the PC which
is running Think & Do software.
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Starting a New To start a new configuration, select the
Screen in I/0 View Configuration menu, then New as
C Help
shown.
Open... g Chrl+0
Frint Setup...
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The next screen is divided into three regions separated by window splitter bars. You
can re-size the regions by doing a click-and-drag on a splitter bar.

Each project maintains its own record of

BB Corfgustion Y Deews Dgecss Jook Window Moo =lelx

its 1/0O configuration. Dl 2] 1Al iz sl

The first time you open the I/O View win- | ||
dow for a new project, it will prompt you
to choose an /O driver, as shown below.

I Mol o gedibis e g coriiasion
Ploase it 11D dven ey Denes -3 A commar

[” Boad indo /" Tosdtina it Nodde info_ AT

Fix Help. poess F1

Selecting a Driver  Use the Drivers menu and select Add, as | EIopr™
shown, to access a list of I/O drivers.
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Select the PLCDirect Ethernet 1/0 Add 10 Driver
driver. Click OK.

Select 1/0 Driver :

PLC Ditect Etherriet 1/0 i

D ouloi Motion

Diual Port FAM - 10 Port Driver
Honepwel 505 1/0
Opto 22 OPTOML 1/0
FPLL Direct Ethernet |0
Prafibuz Synergetic DPM 1/0
Serial Driver

Sunx §-Link 140
TnDAcroLoop Mation (Beta)
TnDSerplex Driver [Beta)
TrnDSynergetic Devicenat DPM [Beta)
ThDT ag Link Driver
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I/0 View adds the driver, and attempts {0 —————— RriE
activate the network adapter card. I/O 5% ==

view displays an image of the card as

shown to the right.
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H4-EBC Base Select the Configuration pull-down _ _ _

Configuration menu from the I/O View menu bar as o = Spt feme e st e

Screegrlm shown to the right. Then select Connect —‘f T & Pl vl
from the menu. This instructs Think & Do [~ s s [ =
to make the connection to the I/O bases || 75
currently on the network. I c
The module must have a non-zero :—mjl 2
Module ID set on the DIP switch or an iy I T
error message will be returned at this F— £ 3
point. See page 2-4 “Setting the DIP R =l m o
Switch” for more information. |_Et— et | O <>_2__

=5

Think & Do makes a connection to the H4—EBC and automatically displays the g
H4-EBC Base Configuration screen. The screen will overlay the I/O View screen. e

Discrete and analog modules are both displayed initially as a dashed horizontal line
“———"in the block representing the module’s slot location.

If you have digital inputs and outputs but no analog inputs or outputs, you do not
need to do anything additional to configure the base. You may click on Exit or Update
Base. Either will return you to the 1/0O View screen.

H4-EBC Base Configuration

The H4-EBLC cannot distinguizh between analog and 16432 bit dizcrete modules. To allow proper operation of analog modules. please configure your
analog modules in the matrix below.

If the module at a particular slot is analog. select the name of the module, athenwize select "---m- " for digcrete modules.

Blaze Mumber: 1

Slt0 | Sltl | stz | st | siet4 | Slets | sieté | stz |
Basel | - | [ v [H4-HsC
Exp 1
Exp 2
Exp 3

Update Baze I Exit | Help |

Note: High Speed Counter module may be indicated
as D4-HSC or H4-HSC. They are the same.
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Identifying You must identify each analog input or output module by selecting the applicable part

Analog Modules number on the Base Configuration screen. The part numbers of all available analog
modules appear on the pull-down menu for the appropriate slot (the part number is
printed on the face of each module). Click on the arrow beside the slot location to see
the menu. The H4-EBC automatically distinguishes between input modules and
output modules. In the Think & Do implementation of the Base Configuration utility,
the pull-down menu for analog input modules lists only analog input modules. It does
not list analog output modules.

H4-EBC Base Configuration E3

The H4-EBC cannot distinguizh between analog and 16432 bit discrete modules. To allow proper operation of analog modules, please configure your
analog modules in the matrix belaw.

If the module at a particular slot is analog, select the name of the module, otherwize select ' " for discrete modules.

Baze Mumber : 1

St0 | Slotl [ stz | stz | slot4 | slts | st | slet? |

Emel | v = = B ~ |[Ha-HsC
Exp 1 D4-02D4 |-
Exp2 F4-04D4
Exp 3 F4-04D4-1

F4-04D4-2

F4-03D4-1 |

F4-16D4-1 | ™ Update Base I Exit | Help |

The pull-down menu for analog output modules lists only analog outfput modules.

F4-02AD
F4-08THM |~ e Bt | Hep |

After selecting the appropriate part number for your analog input or output modules,
click on Update. This will save the entries to the H4—EBC’s non-volatile memory.

After clicking on Update, a graphical representation of the H4—-EBC, the base, and
I/O modules appears. You have successfully configured the 1/0 base. The I/O View
screen shows an eight-slot base even if you are using a smaller base. Expansion
bases are also shown if connected.

D H4-EBC Base Configuration [ x|
o3 The H4-EBELC cannot distinguizh bebween analog and 16432 bit discrete modules. To allow proper operation of analog modules, pleaze configure pour
ol analog modules in the matriz below.

O .,c_, If the module at a particular ghat iz analog. select the name of the module. otherwize select - ! for digcrete modules.

. ; Basze Mumber: 1

ko] 8 Slot0 | Slotl Sot3 | Slot4 | sits | sote | Slot7? |

GC.) w Basel | - | H4-HSC

o | Exp 1 D4-0440 |«

o < Exp 2 F4-044D 32

< T —— F4-044D 16

ad F4-044D5
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Appendix D

Using the H2-EBC
with KEPwareEX
OPC Server

In This Appendix. . . .

— Introduction to KEPServereX

— KEPServerEX Project: Adding and Configuring a Channel
— KEPServerEX Project: Adding and Configuring a Device
— KEPServereX Project: Adding Tags to the Project

— H24-EBC |/O Addressing
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Introduction

Introduction
to OPC

DDE Support

KEPServerEX

Channel ObJeCt File Edit Yiew Users Tools Help

Device Object

Group Object

Tag Object

to KEPServerEX

OPC, OLE (Object Linking and Embedding) for Process Control, is an industry
standard created by a number of worldwide leading hardware and software
suppliers in cooperation with Microsoft. The OPC Data Access specification, as
maintained by the OPC Foundation, is a non—proprietary technical specification that
defines a set of standard interfaces based upon Microsoft's OLE/COM technology.
An OPC server (driver) allows items such as distributed control systems,
programmable logic controllers, I/O systems and smart field devices to
communicate with a wide range of HMI/SCADA (client) software packages residing
on a PC. Traditionally, each software or application developer was required to write a
custom interface, or server/driver, to exchange information with hardware field
devices. OPC eliminates this requirement allowing manufacturing customers true
plug and play connectivity and the freedom to choose products based on their
automation requirements.

While KEPServerEX is first and foremost an OPC server, KEPware recognized that
a number of legacy applications still depend upon DDE for their underlying client
server technology. Early in the development of Windows, Microsoft provided a
generic client server technology called DDE (Dynamic Data Exchange). DDE did
provide a basic architecture that would allow many windows applications from a
wide range of vendors to share data. But there was one problem, DDE was not
designed for the industrial market lacking much of the speed and robustness desired
in an industrial setting. However, this did not stop DDE from becoming a dominant
client/server architecture, largely due to its availability in most windows applications.

KEPServerEX Enhanced OPC/DDE Server is a 32 bit windows application that
provides a means of bringing data and information from a wide range of industrial
devices and systems into client applications on your Windows PC. KEPServerEX
falls under the category of a "Server” application. It is very common to hear the term
“client/server application” in use across many software disciplines and business
segments. In the industrial market, it has usually come to mean the sharing of
manufacturing or production data between a variety of applications ranging from
human machine interface software and data historians, to large MES and ERP
applications.

At a high level, the KEPServerEX OPC Server is comprised of several objects that
are described on the next page.

< KEPServerEx - [untitled opf =] =] 3

DSH ML - s 22X A

= ‘é? Channelj Tag Mame | Address I [iata Type | DOE Scan I Scaling | Description
= Devicel HTagl 50.000 Boolean 100 Mone

4| i
Date | Time I User Name | Source I Ewent %I
|<I | | |

Ready Clients: 0 |Active tags: Dof 0 &
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Channel Object: Each protocol or driver used in a KEPServerEX project is referred
to as a channel. A channel refers to a specific communications driver. A
KEPServerEX project can consist of many channels each with unique
communications drivers or each with the same communications driver.

Each channel name must be unique in a KEPServerEX application. The channel
name entered here will be part of the OPC browser information.

Device Object: Unlike the channel name, "Device names” can be the same from
one channel to the next. The device name is a user defined logical name for the
device. The device name and channel name will be part of the OPC browser
information as well as a DDE item name. Within an OPC client the combination of
channel name and device name would appear "ChannelName.DeviceName”.

Group Object: KEPServerEX allows tag groups to be added to your project. Tag
groups allow you to tailor the layout of OPC data in logical groupings that fit the
needs of your application. Using tag groups allows multiple sets of identical tags to
be added under the same device. This can be very convenient when a single device
handles a number of similar machine segments. From an OPC client standpoint, the
use of tag grouping allows you to segregate your OPC data into smaller tag lists,
which can make finding a specific tag easier when browsing the server.

Tag Object: KEPServerEX allows both dynamic tags, (tag entered directly at the
OPC client that specify device data) and user defined tags. User defined tags have
the benefit of allowing the tag to be browsed from an OPC client that supports tag
browsing. User defined tags also support tag scaling. Unlike many of the dialogs you
will find in KEPServerEX, the tag properties dialog has a number of features that are
driven by icons. The tag name is part of the OPC browse data. Tag names must be
unique within a given device branch or tag group branch. If your application is best
suited by using blocks of tags with the same names, use tag groups to segregate the
tags.
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KEPServerEX Project: Adding and Configuring a Channel

Running the Server KEPServerEX, like any OPC server, can be started a number of ways. One of the

Adding a Channel

benefits of OPC technology is that your OPC client can automatically invoke the
server when it attempts to connect and collect data from it. In order for this automatic
mode of operation to occur you must first create and configure a project. Once you
have created a project, KEPServerEX will automatically select the most recently
used project when it is invoked by an OPC client.
Initially however, you need to manually invoke KEPServerEX using either the
desktop icon, if you chose to install it, or by selecting KEPServerEX from the
windows start menu. Depending on any changes you may have made to the
appearance of KEPServerEX, once invoked you should be presented with the
following interface. To learn more about the various elements of the user interface
see (Basic KEPServerEX Components).
While discussing how to start KEPServerEX its important to understand what the
system requirements are for running the server. KEPServerEX has been designed
to place as little strain on your system as possible.
Recommended System Requirements:

400Mhz Pentium

64 Megs of Ram

10 Megs of Hard Disk Space

Windows NT(SP6a)/2000 (Strongly recommended for industrial settings)

Available Ethernet Card

A channel refers to a specific communications driver. A KEPServerEX project can
consist of many channels each with unique communications drivers or each with the
same communications driver. Depending on the driver or drivers you have installed
you can define a number of channels within a single project. A channel acts as the
basic building block of an OPC link. Properties like communications port, baud rate,
and parity are contained at the channel level. Each channel name must be unique in
a KEPServerEX project. The channel name can be up to 31 characters long.

To add a new channel to your project you can use the Edit menu > New Channel, the
Toolbar Add Channel, or the “Click to add a channel” dialog.

<. KEPServerEx - [C:\Program FilesAKEP5erverE x\Projects\zernialportsetup. opf =]

File Edit “iew Users Tools Help
R‘] = MR New Channel - Identification <]
----- Click to add a channel, alina I Descriétion
channel name can be from 1 to 31 characters
in length.
It must begin with a letter but the remaining
characters can be any combination of letters,
numbers and the underscaore character.
o ] i
< Back Mest > Cancel | Help |
Date I Time 5
«| | »
Feady |Cligrts: 0 |Active tags: Dof0 i
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Selecting the
Device Driver

Selecting the
Network Adapter

Select the device driver you want to assign to the channel. A driver list will be
presented displaying all of the device drivers that are installed in your system.

<t. KEPServerEx - [C:\Program Files\KEPServeiEx\Projects\serialportsetup.opf *]

File Edit “iew Users Tools Help
O = u | %,;7 nm '@ {2 | New Channel - Device Driver E
Click to add a channel alina I Desantion

Select the device driver pou want to assign ta
the channel

The drop-down lizt belaw containg the names of
all the drivers that are installed on your system.

LDevice driver:

PLCDirect ERC

I™ Enable diagnostics

>
< Back I Hext > I Cancel | Help | J
Date Time 5
| | »
Feady Clients: 0 |Active tags: Oof O b

Selecting the "Enable diagnostics” check box will enable diagnostic information to
be available to your OPC application for this channel. With diagnostic functions
enabled, diagnostic tags are available for use within client applications. In addition
to diagnostic tags, a diagnostic window is also available when this feature is
enabled. The diagnostic features of KEPServerEX do require a minimal amount of
overhead processing. For this reason it is recommended that you only use the
diagnostic features when needed and disable them when not in use which is the
default case.

The Network Interface selection allows you to select a specific NIC card for the
Automationdirect EBC Ethernet driver to use based on the NIC name or its assigned
IP address. By selecting a specific NIC interface you will be able to force the driver to
send all Ethernet communication through the specified NIC. If you do not kno
which NIC you should use, select the "Default” condition.

<t KEPServerEx - [untitled. opf]
File

Edit Wiew Users Tools

M=) |

Help

LA

TagHame | Addiess | DalaType | DDE Scan.. | Sealing | Deseiption

New Channel - Network Interface [<]

This channel is configured to communicate aver
& netwark. You can select the network adapter
that the driver should use from the list below.

Select ‘Default’ if pou want the operating system
to choose the network adapter for you

Metwark Adapter:
[Detau

3Com Etherlink PCI [192.16810.62]

Date

Ready

ELMNK3 Ethemet Ad.. [192. 168 81.21] I

i | Nefido/an dapter [0.0.0.0]
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Setting the
Server Writes
Optimizations

As with any OPC server, writing data to your device may be the most important
aspect of your application. Insuring that the data written from your OPC client
application gets to the device in a timely manners is the goal of the server.
KEPServerEX provides a number of optimization settings that can be used to tailor
the server to meet the needs, and improve the responsiveness of your application.

There are currently three write optimization modes. The following is a brief
description of the modes. For a detailed explanation, refer to the “Channel
Properties — Write Optimizations” section in the KEPServerEX on-line help file.

NOTE: We strongly suggest that you characterize your application for
compatibility with these write optimization enhancements before using them
in a production environment.

The default mode, "Write all values for all tags” will force the server to attempt to
write every value to the controller. This mode insures that everything written from
your OPC client applications will be sent to the target device. While writing every
value to the device may seem like the best course of action, there are a number of
applications where writing every value, many of which may be the same value, over
and over may be simply a waste of communications bandwidth.

The "Write only latest value for non—-boolean tags” allows any value that is not a
boolean value to be updated in the server’s internal write queue and will then be sent
to the device at the next possible opportunity. This can dramatically improve the
overall performance of your application. This feature must be used with a clear
understanding of how it will affect the operation of your application.

The final write optimization mode, "Write only the latest value for all tags”, takes
the operation described for the second mode and applies it to all tags.

The Duty Cycle selection allows you to control the ratio of write operations to read
operations. By default the duty cycle is set to ten. This means that ten writes will
occur for each read operation. If your application is doing a large number of
continuous writes but you need to insure that read data is still given time to process,
you may want to reduce the Duty Cycle. A setting of one will result in one read
operation for every write operation. In all cases if there are no write operations to
perform, reads will be processed continuously.

<+ KEPServerEx - [untitled.opf]

Fle Edt Wiew Users Iook Help
W = il R e e

[~ Click to add a channel [TagMame [ Address [ DataType | DDE Scan... | Scaling [ Deseription

New Channel - Wiite Optimizations

i
Wi & for non-baolean tags
€ Wite only latest valu for all tags

Duty £ 5
Perfom [0 = witesfor every 1 read

Date L ( =

Qusm 41245 FM [i

Li Fr 43328 PM L

<Back | New> | Cancel Hep |
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Saving the New
Channel Settings

Using Multiple
Channels in a
Project

With Channel1l added to the server, the KEPServerEX window will appear as
follows:

o

DEE|2ilas |- 4 BE x| &

=--4+C, Channell TagName | Address [DataType | DDE ScanF... | Scaling [ Description
M Click to add a device.

4 | »l

[ pate [ Time [ User Name [ source [ Event [

Ready Cllents: 0 [activetags: 0of0 7

Note that the channel is shown using the channel name given, but it also has a small
red ”x” below the channel icon. The red ”x” indicates that the channel does not
contain a valid configuration. Channel1 is not valid because a device has not yet
been added to the channel.

KEPServerEX supports the use of multiple channels. As you add channels to your
project you can specify either the same communications driver or different
communications drivers. Most communication drivers offered by KEPware support
operation on up to 16 communications ports or ethernet network connections
simultaneously. By defining multiple channels you can improve the overall
performance of you application. In the case of either a serial driver or Ethernet driver
using multiple channels allows you to spread large communications loads across
the multiple channels. A good example of this would be a serial driver that is being
used to communicate with eight devices on the serial line. Normally the
communications driver used in this application would be responsible for gathering
data from all eight devices in a round robin fashion. If this same application is
reconfigured to use multiple channels assigned to multiple communications ports,
the device load can be divided across the channels. The end result is reduce work
load on each channel and dramatic improvements in the responsiveness of you
application. The need to use multiple channels is dependent solely on the needs of
your application. In either case there is no additional cost involved to use a licensed
driver on multiple communications or Ethernet ports.

0dO d8temd3y/0d93—<¢H
g xipuaddy
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KEPServerEX Project: Adding and Configuring a Device

Adding a Device Once a channel has been configured in a KEPServerEX project, a device must be
added to the channel. Devices represent PLCs, I/O devices or other hardware that
the server will communicate with. Device selection is restricted by the device driver
the channel is using.

To add a device to a channel, select the desired channel and use the Edit menu >
New Device, the Toolbar Add Device, or the “Click to add a device” dialog.

< KEPServerEx - [untitled. =18 x|
File Edit Wiew Users Tools Help

Oe | ol el lE]New Device - Name
EH/;'Z Channel1

----- m Click. to add a device,

. Description
device name can be from 1 to 31 characters

in length.
It must begin with a letter but the remaining

characters can be any combination of letters,
rumbers and the underscore character.

Device name:

< Back I Mext » I Cancel | Help | —LI
Date | Time:
< | [
Ready [Clierks: 0 |Active tags: Oof 0 v
Selecting the The "Model” parameter allows you to select the specific type of the device
Device Model associated with a device ID. The contents of the model selection drop down will vary
depending on the chosen communication driver.
O
% <. KEPServerEx - [C:\Program Files\KEPServerE x\Projects\zerial. opf] 1 ] B3
File Edit %iew Users Tools Help
e % V=L =L e Device - Model =
.'(_j ng_ E-%” Channel The device you are defining uses a device EISC&M Dkl
c w ;Iriver that supports more than one model. The
() % list below shows all supported models.
% B Select a model that best describes the device
<C s o are defining,
i
Al
L Device model:
:

< Back I Mext > I Cancel | Help | ﬂ

Date Time n
4| | »

|Clients: 0 |Active tags: Dof 0 /4
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Selecting the The "Device ID” parameter allows you to specify the driver specific station or node

Device Model address for a given device. Since the Automationdirect EBC driver is an Ethernet
based driver, a unique and valid TCP/IP address must be entered. IPX protocol is not
supported.

<1 KEPServerEx - [untitled.o =10 x|
File Edit ‘Wew Users Tools Help
NewDevice—ID x|
[E-42f; Channell : : : I Desctiption
m Click ko add a device The device you are defining may be multidropped as
part of a network. of devices. |n order to communicate
with the device, it must be assigned a unique 10
‘our documentation far the device may refer to this as
a""Metwark D" or "Metwork Addiess."
Device [D:
1921682314
[ ] o
< Back Mext » Cancel | Help |
Date I Time
| | o
Ready |Clients: 0 |Active tags: 0of 0 v

Setting the Device Device timeout parameters allow a driver’s response to error conditions to be

Timeout Properties tailored to the needs of your application. The timeout parameters are specific to each
device you configure. Each of the field parameters is defined in detail in the “Device
Properties — Timeout” section in the KEPServerEX on-line help file.

< KEPServerEx - [untitled.o o =]}
File Edit Wiew Users Tools Help
= | el jjjj e K| New Device - Communications Parameters x|
E--@ Channell . . I Description
im] Click to add a device Enter the parameters you wish to use while T
communicating with the device N
Connect timeout refers ta the time to wait for 2 I
successhul initial connection. m
vy}
Request timesout refers ta the time to wait for a >
request to be serviced Q g
A
- ms
Connect irmeout: |3 _|; seconds Ta
P =i =X
Request timeaut: |1000 = miliseconds E o
D
Fail after |3 _I::l successive timeouts O
S
e | |
< Back Mext » | Cancel | Help
Date | Time
1 | |
Ready |Clients: 0 [Active tags: 0of 0 g

The Connection timeout: allows the time required to establish a socket connection
to a remote device to be adjusted. The Request timeout: is used by all drivers to
determine how long the driver will wait for a response from the target device. The
Fail after parameter is used to determine how many times the driver will retry a
communications request before considering the request to have failed. If your
environment is prone to noise induced communications failures you may want to
increase the number of retries the driver performs.
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Automatic OPC
Tag Database
Generation

Saving the New
Device Settings

The automatic OPC tag database generation features of KEPServerEX have been
designed to make the setup of your OPC application a Plug and Play operation.
Since the Automationdirect EBC communication driver supports this feature, you
can configure it automatically build a list of OPC tags within KEPServerEX that
correspond to device specific data. The automatically generated OPC tags are then
browsable from your OPC client. The OPC tags that are generated are dependent
upon the nature of the supporting driver. Each field selection is defined in detail in the
“Automated OPC Tag Base Generation” section in the KEPServerEX on-line help
file.

g 3]
Dﬁnﬁ?m&‘@ x|
54, Channell Description
-~ Click tor add & device
< Back Next> Carcel | Hep | "]
[oate  [Tim =
4| | _’l_l
Ready Clients: 0 |Active tags: 0 of 0 v

The "Automatic tag database generation on device startup” selection allows you
to configure when OPC tags will be automatically generated. There are three
possible selections. The default condition, "Do not generate on startup”, will
prevent the driver from adding any OPC tags to tag space of KEPServerEX. The
selection "Always generate on startup”, will cause the driver to always evaluate
the device for tag information and to add OPC tags to the tag space of the server
each time the server is launched. The final selection "Generate on first startup” will
cause the driver to evaluate the target device for tag information the first time this
KEPServerEX project is run and to add any OPC tags to the server tag space as
needed. When the automatic generation of OPC tags is selected, any tags that are
added to the server’s tag space must be saved with the project. You can configure
your KEPServerEX project to auto save from the Tools > Options menu.

With Device1 added to Channel1, the KEPServerEX window will appear as follows:

< KEPServerEx - [untitled.opf *] = =10ix]
Fle Edi View Users Toos Help

Dl Ploof | o tBRX 2

=427 Channell TagName | Address [DataType | DDE Scan R... | scaling [ Description

) Click to add  static tag. Tags are nok required, but ars browsable by OPC dlients.

4] |
[ate [ Time [ User Name [ Source [ Event

L BT
Ready [Clients: 0 [active tags: Def0 2

il
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KEPServerEX Project: Adding Tags to the Project

There are two ways to get data from a device to your client application using
KEPServerEX. The first method, and most common method, of defining tags is
called User Defined Tags. This requires that you define a set of tags in the server
project and then use the name you assigned to each tag as the item of each
OPC/DDE link between the client and the server. The primary benefit to this method
is that all user defined tags are available for browsing within OPC clients.
Additionally, user defined tags also support scaling.

The second method of defining tags is called Dynamic Tags. Dynamic tags allow
you to define tags in the client application. Instead of providing the server with a tag
name as the OPC/DDE item, you would provide the device address (and optionally a
data type). The server will create a tag for that location and start scanning for data
automatically. KEPServerEX allows tag groups to be added to your project.

Tag groups allow you to tailor the layout of OPC data in logical groupings that will fit
the needs of your application. Using tag groups allows multiple sets of identical tags
to be added under the same device. This can be very convenient when a single
device handles a number of similar machine segments. From an OPC client
standpoint, the use of tag grouping allows you to segregate your OPC data into
smaller tag lists, which can make finding a specific tag easier when browsing the
server.

User Defined Tags Each field selection is defined in detail in the Tag Properties section in the
KEPServerEX on-line help file. A brief description of each is listed below.

2 KEPServerEx - [ungs
D& @il e scaia]
-5 Channell T
.l Devicel 1 b
gl
@e ==
|
T
I})
Datagm Default - Q
Client access:  JRead/wfite hd O'g
S~~~
DE seanvte /(100 =] millseconds Xg
m 3
Do not allow clients to gveride data & ol Vo
Date Tim - = X
‘ oK Cancel ) Hep ]| v ) o
Fieady - hivetags 3ol g o
3

The tag Name: parameter allows you to enter the string that will represent the data
available from this tag. The tag name can be up to 31 characters in length. While
using long descriptive names is generally a good idea, keep in mind that some OPC
client applications may have a limited display window when browsing the tag space
of an OPC server. The tag name is part of the OPC browse data. Tag names must be
unique within a given device branch or a tag group branch. If your application is best
suited by using blocks of tags with the same names, use tag groups to segregate the
tags.
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The Address: parameter allows you to enter the desired driver address for this tag.
To determine how an address should be entered, you can use the Hints button next
to the address parameter. Hints provide a quick reference guide to the address
format of the driver. Once you have entered an address you can test it by using the
check address button. When pressed, the check address button attempts to validate
the address with the driver. If the driver accepts the address as entered no message
will be displayed. If an error is detected a pop—up will inform you of the error. Keep in
mind that some errors will be related to the data type selection and not the address
string.

The Description: parameter allows you to attach a comment to this tag. A string of
up to 64 characters can be entered for the description. If you are using an OPC client
that supports Data Access 2.0 Tag Properties, the description parameter will be
accessible from the Item Description property of the tag.

The Data Type: selection allows you to specify the format of the tag’s data as it is
found in the physical device. The data type setting is an important part of how a
communication driver reads and writes data to a device. For many drivers the data
type of a particular piece of data is rigidly fixed.

The available data type selections are:

» Default — This type allows the driver to choose its default data type see the
specific driver help for details

¢ Boolean — Single bit data On or Off

e Char - Signed 8 bit data

¢ Byte — Unsigned 8 bit data

e Short — Signed 16 bit data

* Word — Unsigned 16 bit data

¢ Long — Signed 32 bit data

* Dword — Unsigned 32 bit data

* Float — 32 bit Real value IEEE format

e String — Null terminated ASCII string

e Double — 64 bit Real value IEEE format

e BCD - Two byte packed BCD value range is 0 — 9999

e LBCD - Four byte packed BCD value range is 0 — 99999999

The Client access: selection allows you to specify whether this tag is Read Only or
Read/Write. By selecting Read Only you can prevent client applications from
changing the data contained in this tag. By selecting Read/Write you are allowing
client applications to change this tag’s value as needed.

The DDE scan rate: parameter allows you to specify the the update interval for this
tag when used in a DDE client. OPC clients can control the rate at which data is
scanned by using the update rate that is part of all OPC groups.

The Do not allow client to override data type selection allows you force OPC
clients to use the data type you have specified for this tag. OPC clients can specify
how they desire to view the data from a particular tag.
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Creating a To determine how an address should be entered, use the Hints button “?” to the right
User Define Tag of the address field. Hints provide a quick reference guide to the address format of
the driver.

<t KEPServerEx - [ung - =10 x]
Flo Edt View Lisr: MGG
nDE g | o7 i General |Sca|mg|
E7 Charrell ~ |dentification in Description
M Devicel r =il | 4 I DJ 3
Hints E
E
S1:B0D00 - 5253:50255 Byle B i3 J
S1:BOD00 - 5253:80255 Char J
51:DBI00D - 5253 DBIZSS Float
51:DBO00D - 5253:DBO25S Float ﬂl
L |51:DI000 - 5253.D1240 Short
[ |5t:DI000 - S253DI240 word &I
51:D1000 - 575301243 Bute
51:D1000 - 5253.DI255 Boolean
51:D0000 - $253.00240 Short
51:00000 - 525300240 Word [
£1.o010
T
¥ Do not dllow clients ta overide data tupe, o
Date Tirn -
« ok | cancel | oz | Hee | | v
Fieady rtvetags Joi3 g

Once you have entered an address you can test it using the check address “»”
button. When pressed, the check address button attempts to validate the address
with the driver. If the driver accepts the address as entered, no message will be
displayed. If an error is detected, a pop—up window will inform you of the error. Keep
in mind that some errors will be related to the data type selection and not the address
string. Below is an example of a valid tag properties.

-Ioix
Fie Fb Vew Ussrs K|
0w @@ il L General | Scaing|
Erd ﬁﬁannell PPEP— escription
Devicel I
Name: [[npa_0 =l LI LI
Address: [51010 Llil EI EI
_ x|
Deseriptior IMndu\eS\ntT,DEFrnxSensan
- Data propeti
Data type: lm
Client aceess: [Read Orly - T
DDE scanate:  [100 _13 milissconds [})
¥ Do not allow clients to overide data type. | Q
Toe : oZ
- 0K | Cancel | Apph | Hep | | _’l_l 7 g
Ready CTemts: 0 JActive tags: 0 of 0 4 A D
ms
, , , . Ja
The window below shows a valid configured channel, device and several use 5 P
defined tags. = O
(0]
1 KEPServerEx - [untitled opf 7] @]
File  Edit Yiew Users Tools Help -U
DedPloas = b B0 x| 2 Q)
1= 4P Channell Tag Name [ Address [ Data Type | DDE Soan .. | Scaling Desciiption
~{M Devicel #5et ot lo ASCIL. EBC:SPOMODE  Bute 100 Naone
@ utpitd Rl Boolsan i Hore:
(JASCI_DataInput  EBC:SPODAT.. Sting 100 None:
4] | |
Date [ Time [ User Name [ 5ouce [ Event
| | L2
Ready Clents 1 |Aclivetags: 3of3 4
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H2-EBC I/0 Addressing

I/O slots must be individually addressed in the following form: S<ss>:<t><nn> where
ss is the slot number (0 to 8), t is the address type (X, Y, K, V, DI, DO, WI, WO, etc.),
and nn is the address. The address ranges from 0 to an upper limit determined by the
module occupying the slot.

nn = Bit Number (decimal)

I/O Type Syntax Data Type
Discrete Inputs X or Dl<nn> Boolean, Byte, Char,
nn = Bit Number (decimal) | Word, Short, DWord, Long
Discrete Outputs Y or DO<nn> Boolean, Byte, Char,

Word, Short, DWord, Long

nn = Bit Number (decimal)

Byte Inputs Bl<nn> Byte, Char
nn = Bit Number (decimal)

Byte Outputs BO<nn> Byte, Char
nn = Bit Number (decimal)

Word Inputs K or Wi<nn> Word, Short
nn = Bit Number (decimal)

Word Outputs V or WO<nn> Word, Short
nn = Bit Number (decimal)

DWord Inputs DWI<nn> DWord, Long
nn = Bit Number (decimal)

DWord Outputs DWO<nn> DWord, Long
nn = Bit Number (decimal)

Float Inputs Fl<nn> Float
nn = Bit Number (decimal)

Float Outputs FO<nn> Float
nn = Bit Number (decimal)

Double Inputs DBl<nn> Float
nn = Bit Number (decimal)

Double Outputs DBO<nn> Float

H2-EBC 1/0 Each field selection is defined in detail in the “Tag Properties” section in the
Addressing KEPServerEX on-line help file.
Example
H2-EBC Slot 0 Slot 1 Slot 2 Slot 3 Slot 4 Slot 5
Module 8 Inputs 32 Inputs 4 Analog Inputs 8 Outputs 16 Outputs 8 Analog Outputs
Addresses | Addresses Addresses Addresses | Addresses Addresses
S0:X0 S1:X0 S2:K0 S3:Y0 S4:Y0 S5:V0
to to to to to to
S0:X7 S$1:X31 S2:K3 S3:Y7 S4:YI5 S5:V7




Appendix E
Using the KEPwareEX
OPC Quick Client

In This Appendix. . . .

— Creating a KEPServerkEX Quick Client Project
— Using the RJ12 Serial Port in ASCII Mode
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Creating a KEPServerEX Quick Client Project

Connecting the
Client to the
OPC Server

Creating a Client
Group

KEPServerEX Quick Client can be used to assist in the test and development of
KEPware’s OPC Data Access 1.0 and 2.0 Servers.

A server connection provides a link between the Quick Client and the KEPServerEX
OPC server. To add a server connection to the Quick Client, you can use either the
Edit menu>New Server Connection or click on the New Server icon in the toolbar
menu.

OPC Quick Client - Untitled
File Edt Wiew Took Help

ﬁ o | General |

Flegistered Servers:
&) OPC Daia

Timestamp

&, [
OPC Gen

Brog ID [KEPware KEPServerEx vd

Riemote Machine Name: |

0k | caed | Hep | |

Ready [tem Count 0

Specify the Prog ID of the OPC Server the client should connect to. You can browse
for registered servers by expanding any of the branches. Double—clicking on any
registered server will automatically update the Prog ID field. For more information on
the registered servers, click on the Help button to display the “Server Connection”
section of the on-line help file. Once a connection to the OPC server has been
established, additional “Server Operations” can be accessed by right clicking on the
highlighted server in the right window column or by using the Tools menu>Server
selection.

A group is used to organize a collection of items with a common set of properties. To
add a Group to the Quick Client, you can use the Edit menu>New Group or click on
the New Group button in the toolbar menu.

OPC Quick Client - Untitled *

He Fit Yev Loy He
DEELc ) s
eeeee

|
:i KEPware KEPServerEx.V4 |

MName:

myarou
100

Update Bate (ms.:
Time Bias (min.;
Percent Deadband:

Language |D:

1033
oPca2n 2

Update Natification: ¥ Active State

0k | Cancel | Heb | I

Ready [tem Count: 0%

A The group specifies the following properties: group Name, Update Rate, Time
Bias, Percent Deadband, Language ID, Active State and the typeof data
connection that should be made to the server. For detailed information on the group
properties, click on the Help button to display the “Group” section of the on-line help
file. Once a Group has been created, additional “Group Operations” can be
accessed by right clicking on the highlighted branch Group or by using the Tools
menu>Group selection.
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Selecting a
Group ltem

Items represent data that may be accessed via the OPC server. An item specifies
the following properties: Access Path, Iltem ID, Data Type and Active state. For
detailed information these properties, click on the Help button to display the ltem
section of the on—line help file. To add an Item to the Quick Client Group, you can
either use the Edit menu>New Item or click on the New ltem icon on the toolbar.

OPC Quick Client - Untitled = 19 =] B
File Edit View Tooks Help Add Items [=]
DEE o a8 ¥ o o
=+ KEPware KEPSEvEE VA estamp

/3 mygroup Acsess Pt | 4 ‘ Cancel
ltem[D: [Channell.Devicel Siatz Duputd w| | Help
Datalype: [Bookan = @ =
Active ~
~Browsing
Branch Filter. LeafFiter  Tupe Agcess
- [ [Native: =] Jany =]
- KEPware KEFServerEx V4 4 Channel]. Device1.Slot2. Duputd
=@ Channell
£l Devicel
{8 _System @
@8 _Hints
-5 [Slot2 i
Dale Time
[¥ Browse flat address space on selected branch Add Leaves
I~ Validate item before adding it to the fist @Em Count; 1
Peady Teem Lount. 0/

If the OPC Server was configured to automatically generate OPC tags, the
generated tags would be browsable from the OPC client. If automatic tag generation
was not selected, create an item by:

1) browsing the OPC Server branch tags

2) highlighting the desired tag in the right column

3) clicking on the “Add Leaves” button

4) clicking on the “Green Check Mark” button to validate the item

5) and clicking on the “OK” button.

After clicking on the OK button, the following window will display the created items.

OPC Quick Client - Untitled * [C[OIX]
Fie Edt View Tools Help
DSHde @ & BRX
=+ KEPware KEPServerEx vd Item D Data Type Value Timestamy
----- 23 mygroup Ehannell Device] S0z Dupuid Treriomm
4| | |
Date [ Time | Event ]
@ o/14/01 35616 PM Added 1 items ta group ‘mygroup'
Ready Itemn Count: 1 7
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Item Operations Item operations can be accessed by right clicking on the desired item or by using the
Tools menu>Group selection.

OPC Quick Client - Untitled * [_To] =]
Eile  Edit View Took Help

DS e @)% BexX

-+ KEPware KEPServerEx V4 Item D [ Data Type Walue Timestamp
3 mygroup “Channell Diovice] 5 /g RN Uricrown
Set Active
Set Inactive

Synchionous Cache Bead
Synchionous Device Read
Synchronous Write.

Aspnchronous 2.0 Read
Asynchronous 2.0 Cache Refresh
Asynchronous 2.0 Device Refresh

A, it

Cut Clrl+
LCopy Ct+C
Easte [Eiil
4 £ »
Delete Del _I J
Date ‘ Time | Ewent | :I
@aaam 417156 PM Added group mygroup_ Fraperties.
0 8/14/0 4:14:08 PM Added 1 items to group ‘mygroup’
0 814/M 4:16:39 PM Added 1 items to group ‘myagroup’.
o 8.14/M 4:16:45 PM Remaved 1 items from group ‘myaroup’.
-
Perform an asyhchronous 2.0 write on the selected items Itern Count: 1~

After clicking on the desired item operation, a window similar to the following will be
displayed. In this example, a logic 1 value (Boolean data type) is being written to a
discrete output to turn it on. The item operations can be used to read discrete/analog
inputs and write to discrete/analog outputs, etc.

OPC Quick Client - Untitled = =
File Edt Wiew Torf) F— =
B e e
B+ KEPwareKEPS  [ltemID) [ Curment ¥alue [ wiite Value | Timestamp
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Using the RJ12 Serial Port in ASCIlI Mode

The H24-EBC RJ12 serial port can be configured for generic ASCII
communications (refer to the “Advanced Settings” section in Chapter 3 to confirm or
change the RJ12 serial port settings). Both the transmit buffer and receive buffer of
the driver are 127 bytes in size. Thus, the corresponding tags can be a maximum of
127 bytes. Incoming bytes are appended to the receive buffer.

Port specifiers precede the serial port address. It defines which port the serial port
address corresponds to. To define an EBC address the mnemonic EBC is used and
the mnemonic SPO specifies serial port 0. For addressing the EBC serial port, no
base or slot information is needed.

As shown below in the Hints dialog, there are several port address parameters. In
many cases the default values can be used. A detailed list explaining the parameters
are found by clicking on the Help button in the Hints window. Then click on the Index
button in the Terminator 1/O, 1/0O Addressing window. Then locate the “H2, H4,
Terminator I/O Serial Port Addressing” help section.

Tag Properties
General I Scaling |
. |
EBC-5PO.EALD Long J
EBC:SPO.DATABITS Byte C |
EBC:SPODATABITS Char ﬂl J
EBCSPODATAIN Sking
EBC:SPO.DATAIN[][c] Byt ﬂl
| |EBC:SPO.DATAIN[][C] Char
o EBC:SPODATAOUT Sting
EBC:5PO.OATADUT(]c] Byte
EBC:SPODATAOUT(rc] Char
EBC:SPO.DIFLUSH Boolean
EBC:SPOMODE Byte
EEC-SPO.MODE Char |
DDOE zcanrate:  [100 ::II milizeconds
¥ Do ot allow clients to overide data type.
QK | Cancel | Aoy Help

The communication parameter defaults are:
e 9600 baud
e 8 data bits (7 may be selected)
e no parity (odd or even may be selected)
e 1 stop bits (2 may be selected)
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Using the KEPware OPC Quick Client

The following tags were created in the KEPServerEX OPC server for this example.
« EBC:SP0:MODE
e EBC:SPO:DATAIN

< KEPServerEx - [untitled. opf =] H[=] E3
File Edit “iew Users Toolz Help

DS E|@DOOE > & B x|

= Q Channell Tag Name I Addiess | Data Type | DDE Scan ... | Scaling | Description

[ Devicel et Port to A5CIL.CEBLSPOMIDE > Byie i0d Hone

l:} Outputd -0 Boolean 100 Mone
IASCI_Data_Input Sting 100 Mone

< | |

Feady |Clients: 1 |Active tags: 3of 3 4

The tags created above were browsed and selected as items within the Quick Client
as shown below. The EBC.SP0.MODE address must be set to a value of 1 to select
the ASCIl communications mode. The ASCII string ASCIl String Input Test
Successful was entered via the RJ12 serial port. The ASCII Sting displays in the
ASCII_Data_Input Item ID’s Value column.

OPC Quick Client - Untitled = M= E
File Edt Yiew Took Help
DEd|sce & &ERX
1) KEPware KEPServer V4 ltem ID [ Data Type [ value [ Timestamp
A mygroup <3 Channell.Devicel.Set_Port_tg 45C1l Mode ____ Bue 1 09:32.36.93
i Tharnel Devicel ASCIL Dats_Input String ASCIl Stiing Input Tast Sucessil——19 301 454
(& ChannelT DEwEeT ottt Ereh + 09:30:22:04
4] | i
Date [ Time [ Event | =
@onmm 3:30:22 4M Asynchionous 2.0 wite transaction DD 248 completed for 1 items on group ‘myaroup’ (HA = 00000000)
@onvm 332,25 M Added 2 items to group ‘mygroup’
@anim 532,37 AM Asynchionaus 2,0 wite transaction 00082164 initiated for T items on group 'myaroup’
@anim 532,37 AM Asynchionaus 2,0 wite ransaction 00082164 completed for 1 items on group mygroup (HF: = 00000000],
Flsady ltem Count 3/
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